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Введение

Настоящее методическое пособие-практикум содержит описание лабораторных
работ, направленных на приобретение навыков проектирования цифровых схем с ис-
пользованием полупроводниковой элементной базы. Лабораторные работы содержат
практические задания как по проектированию схем на низком уровне, на базе поле-
вых транзисторов и КМОП-логики, так и на более высоких уровнях: на вентильном
и уровне регистровых передач (RTL-уровне). В рамках работ также предлагается
ознакомиться с проектированием цифровых схем с использованием микросхем про-
граммируемой логики (ПЛИС) и получить базовые навыки тестирования и отладки
схем на реальной аппаратной платформе с ПЛИС. В практикуме даются рекоменда-
ции по работе с инструментальным обеспечением фирмы Xilinx и отладочной платой
Nexys 4 DDR (новое название — Nexys A7).

Лабораторные работы охватывают следующие темы:

1. Лабораторная работа №1 «Введение в проектирование цифровых интегральных
схем».

2. Лабораторная работа №2 «Разработка аппаратных ускорителей математиче-
ских вычислений».

3. Лабораторная работа №3 «Проектирование цифровых схем с использованием
ПЛИС».

4. Лабораторная работа №4 «Проектирование встроенных схем самотестирова-
ния».

5. Лабораторная работа №5 «Проектирование контроллеров ввода и индикации».

6. Лабораторная работа №6 «Проектирование контроллеров периферийных
устройств».

В качестве базового набора лабораторных работ на семестр предлагается исполь-
зовать лабораторные работы под номерами 1, 2, 3, 4. В качестве усложненного ва-
рианта может быть предложено выполнение комплекса из лабораторных работ под
номерами 1, 5, 6.

В практикуме приводятся описания заданий, требования к отчетам, а также крат-
кие теоретические сведения по выполнению заданий и работе с инструментальным
программным обеспечением.

При выполнении лабораторных работ не по порядку, для лучшего понимания
требований и рекомендуемых способов выполнения работы, следует обращаться к
материалам предыдущих работ.
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Данное методическое пособие рекомендовано для проведения лабораторных за-
нятий студентам Университета ИТМО по дисциплине «Функциональная схемотех-
ника» в рамках направлений подготовки 09.03.01 «Информатика и вычислительная
техника» и 09.03.04 «Программная инженерия».

Для выполнения лабораторных работ практикума рекомендуется использовать
следующее инструментальное обеспечение:

1. LTspice (версия IV или новее).

2. Vivado Design Suite (версия 2017.4 или новее).
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1 Лабораторная работа №1. Введение в проектиро-

вание цифровых интегральных схем

1.1 Введение

Лабораторная работа №1 посвящена развитию навыков проектирования схем на
уровне транзисторов и с использованием вентилей, рассматриваются базовые прин-
ципы построения схем на КМОП-логике.

Для исследования работы электрических схем инженер-проектировщик может
создать прототип устройства на макетной плате или воспользоваться ручными рас-
чётами на бумаге. Однако при разработке интегральной микросхемы создание прото-
типа может быть крайне дорогостоящим и длительным процессом. Сложность таких
схем зачастую не позволяет провести требуемые расчеты вручную. Поэтому при раз-
работке большинства микросхем, а также сложных печатных плат повсеместно при-
меняется компьютерное моделирование. Наиболее известной системой аналогового
моделирования является программа SPICE и её многочисленные наследники. Часть
заданий лабораторной работы будет выполняться в среде моделирования LTspice,
которая относится к классу SPICE-подобных симуляторов электронных схем общего
назначения.

В рамках работы также производится знакомство с принципами проектирования
схем на вентильном уровне с использованием языка описания аппаратуры Verilog
HDL.

1.2 Описание лабораторной работы

Цели работы

1. Получить базовые знания о принципах построения цифровых интегральных
схем с использованием технологии КМОП.

2. Познакомиться с технологией SPICE-моделирования схем на транзисторах.

3. Получить навыки описания схем базовых операционных элементов (БОЭ) ком-
бинационного типа на вентильном уровне с использованием языка описания
аппаратуры Verilog HDL.

7



Указания к выполнению работы

Лабораторная работа состоит из двух частей.
Первая часть посвящена проектированию цифровых вентилей на полевых тран-

зисторах, построению схем на базе вентилей и знакомству с технологией SPICE-
моделирования. Первая часть работы выполняется в программном пакете LTspice.
При построении схем вентилей необходимо использовать КМОП-транзисторы с па-
раметрами из файла, предоставленного преподавателем (см. раздел «Основы работы
в среде LTspice»).

Вторая часть посвящена знакомству с языком описания аппаратуры Verilog HDL,
изучению особенностей его использования для описания схем на вентильном уровне и
приобретению навыков тестирования таких схем. Вторая часть работы выполняется
с использованием Vivado Simulator, входящего в пакет Vivado Design Suite (см. раздел
«Основы работы в среде Vivado Design Suite»).

Порядок выполнения работы

Часть 1:

1. Постройте в LTspice на транзисторах схему вентиля, составляющего основу ло-
гического базиса согласно варианту задания.

2. Создайте символ для разработанного вентиля как иерархического элемента.

3. С использованием созданного иерархического элемента постройте схему тести-
рования вентиля.

4. Проведите моделирование работы схемы и определите задержку распростране-
ния сигнала через тестируемый вентиль.

5. Определите максимальную частоту изменения входных сигналов, при которой
построенная схема сохраняет работоспособность.

6. Постройте БОЭ на базе созданного вентиля согласно варианту задания.

7. Создайте символ для построенного БОЭ.

8. Проведите моделирование работы схемы и определите задержку распростране-
ния сигнала через БОЭ.

9. Определите максимальную частоту изменения входных сигналов, при которой
построенная схема сохраняет работоспособность.

10. Составьте отчет по результатам выполнения заданий первой части лаборатор-
ной работы.
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Часть 2:

1. Опишите на Verilog HDL на вентильном уровне модуль, реализующий функцию
БОЭ в указанном логическом базисе согласно варианту задания.

2. Разработайте тестовое окружение для созданного модуля.

3. Проведите моделирование работы схемы.

4. Составьте отчет по результатам выполнения заданий второй части лаборатор-
ной работы.

Требования к отчету

Отчет должен быть оформлен в соответствии с требованиями, представленными
в Приложении A.

Отчет должен включать:

1. Титульный лист.

2. Цели работы.

3. Задание в соответствии с вариантом.

4. Отчет о выполнении заданий части 1:
− схема разработанного вентиля;
− символ вентиля и схема тестирования;
− временная диаграмма процесса тестирования вентиля;
− результат измерения задержки распространения сигнала через вентиль;
− максимальная частота работы вентиля;
− схема разработанного БОЭ;
− символ разработанного БОЭ и схема тестирования;
− временная диаграмма процесса тестирования БОЭ;
− результат измерения задержки распространения сигнала через БОЭ;
− максимальная частота работы БОЭ.

5. Отчет о выполнении заданий части 2:
− код разработанного модуля БОЭ;
− код разработанного тестового окружения БОЭ;
− временная диаграмма процесса тестирования БОЭ.

6. Выводы по работе.
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Задания по вариантам

№ варианта Логический базис БОЭ

1 NOR Демультиплексор «1 в 4»

2 NAND Полный четырехразрядный компаратор

3 NOR Схема мажоритарного контроля с 5-ю
входами

4 NAND Позиционный шифратор «8 в 3»

5 NOR Преобразователь BCD-кода
в двоичный код (числа от 0 до 99)

6 NAND Позиционный дешифратор «3 в 8»

7 NOR Четырехразрядный двоичный сумматор с
переносом

8 NAND Шифратор кода Грея для трехразрядного
двоичного числа

9 NOR Мультиплексор «4 в 1»

10 NAND Дешифратор трехразрядного кода Грея

10



1.3 Основы работы в среде LTspice

1.3.1 О моделировании в SPICE

SPICE (Simulation Program with Integrated Circuit Emphasis) – программа для мо-
делирования поведения интегральных схем и схем на печатных платах. Изначально
разработана в Калифорнийском университете в Беркли в начале 1970-х гг. В даль-
нейшем на ее основе были созданы другие программы, одной из которых является
LTspice.

Необходимость моделирования вызвана тем, что создать дешевый прототип инте-
гральной схемы практически невозможно – для этого ее надо фактически изготовить,
что является очень затратным мероприятием. SPICE позволяет промоделировать ра-
боту схемы в разных условиях и выявить потенциальные проблемы до того, как она
будет изготовлена.

SPICE содержит модели различных электронных компонентов и элементов схем –
транзисторов, резисторов, конденсаторов, источников напряжения, усилителей и т.п.
Соединяя компоненты, можно построить произвольную схему, а затем подвергнуть
ее анализу одним из поддерживаемых способов: передаточная функция, анализ по
постоянному току, анализ по переменному току и др.

1.3.2 Ограничения области применимости SPICE

Несмотря на то, что SPICE во многих случаях может заменить прототипирова-
ние, часто результаты моделирования могут оказаться недостаточно точными или
даже совсем не совпадать с работой реальной схемы. Реальные электронные ком-
поненты являются сложными устройствами, работа которых зависит от множества
параметров. Результаты моделирования точны настолько, насколько точны модели
компонентов.

Модели схем в SPICE свободны от шумов, перекрёстных помех, паразитных емко-
стей и др., если только они явно не внесены в модель проектировщиком. Например,
сигнал силой в несколько пикоампер может корректно управлять схемой в SPICE-
модели, но в физическом мире будет полностью подавлен шумами и паразитными
цепями.

SPICE-моделирование не подходит для исследования излучающих и принимаю-
щих схем (антенн). Для задач такого рода используются системы, построенные на
численном решении уравнений Максвелла.

SPICE не является лучшим средством для предсказания поломки компонентов.
Моделирование не выдаст никакого предупреждения в случае, если будет превышено
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максимально допустимое значение тока или напряжения для какого-либо из компо-
нентов. Например, проектировщик может не заметить тока в несколько ампер на
одной из цепей при моделировании схемы, но после изготовления такая схема при
включении сгорит.

1.3.3 О программе LTspice

Загрузить программу LTspice можно с сайта компании Analog Devices по
адресу: https://www.analog.com/en/design-center/design-tools-and-calculators/
ltspice-simulator.html. Программа является бесплатной. Доступны версии под
Windows и Mac OS, под Linux LTspice можно запустить в Wine. Версия для Mac OS
имеет некоторые отличия от версии для Windows.

LTspice имеет встроенную справку с описанием основных приемов работы. Также
в интернете можно найти множество уроков и статей по использованию LTspice.

В лабораторных работах будут использоваться модели транзисторов для техпро-
цесса 90 нм, полученные путем моделирования. Цифра в названии технологии, как
правило, означает минимальную длину канала транзистора. Так как увеличение дли-
ны канала транзистора в цифровых схемах не дает никакого положительного эффек-
та, все транзисторы в рамках выполняемых работ будут иметь длину канала, равную
90 нм. Минимальная допустимая ширина канала обычно в два раза больше мини-
мальной допустимой длины, т.е. для техпроцесса 90 нм минимальная ширина канала
равна 180 нм. Увеличение ширины канала увеличивает его проводимость и емкости
между затвором и каналом.

1.3.4 Создание инвертора и моделирование его работы

Рассмотрим основные принципы работы в среде LTspice и познакомимся с КМОП-
схемотехникой на примере простейшего цифрового вентиля – инвертора.

Подготовка к работе

Создайте рабочий каталог для сохранения файлов проекта. Загрузите файл
90nm_bulk.txt с параметрами транзисторов (предоставляется преподавателем) и со-
храните его в своем рабочем каталоге. В этом же каталоге следует сохранять созда-
ваемые схемы (файлы *.asc, *.asy).

Запустите программу LTspice. Окно программы представлено на рисунке 1.1.
В меню Tools → Color Preferences можно настроить цвета, в которых изобража-

ются рабочее поле и схема. Необходимо выбирать светлый фон и темные линии при
подготовке иллюстраций к отчету.

12

https://www.analog.com/en/design-center/design-tools-and-calculators/ltspice-simulator.html
https://www.analog.com/en/design-center/design-tools-and-calculators/ltspice-simulator.html


Рисунок 1.1 – Окно программы LTspice

Включить отображение сетки в рабочем поле можно с помощью View → Show
Grid.

Создание и симуляция схемы

Создайте новую схему (File → New Schematic) и сохраните ее файл в своем рабо-
чем каталоге (File → Save As...). Добавьте к схеме SPICE-директиву, подключающую
параметры транзисторов (Edit → SPICE Directive, рисунок 1.2). Помните, что дирек-
тивы SPICE начинаются с точки. Разместите директиву на схеме (рисунок 1.3).

Рисунок 1.2 – Окно ввода директивы

Рисунок 1.3 – Директива, вставленная в схему

На рисунке 1.4 показана схема тестирования инвертора – простейшего цифрового
вентиля. Схема включает: КМОП-инвертор из двух транзисторов (PMOS и NMOS),
источник питания инвертора (VDD1), источник тестового входного напряжения (V1)
и нагрузку выхода инвертора (R1 и С1). Нагрузка необходима, чтобы моделировать
реальную ситуацию, когда выход инвертора управляет другими вентилями.
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Постройте схему. Для этого добавьте на схему транзисторы pmos4 и nmos4, ком-
поненты voltage, res, cap (Edit → Component) и землю (Edit → Place GND). Сориен-
тируйте элементы нужным образом (Edit → Rotate и Edit → Mirror), а затем соеди-
ните проводами (Edit → Draw Wire). Проводам можно присваивать имена с помощью
Edit → Label Net (только ввести имя, тип порта оставить None). Если присвоить двум
проводам в разных местах схемы одинаковое имя, это будет эквивалентно их соеди-
нению. На схеме тестирования инвертора таким образом соединены все фрагменты
провода с именем VDD.

Рисунок 1.4 – Схема тестирования инвертора

Отредактируйте параметры компонентов в соответствии со схемой на рисунке 1.4.
Для редактирования параметров необходимо щелкнуть на компоненте правой кноп-
кой мыши.

Для транзисторов необходимо ввести длину и ширину (l и w) канала в наномет-
рах. Заметьте, что ширина канала PMOS-транзистора в два раза больше, чем ширина
канала NMOS-транзистора. Это связано с тем, что мобильность дырок примерно в
два раза ниже мобильности электронов. Следовательно, чтобы обеспечить одинако-
вую проводимость каналов, ширину PMOS-канала нужно сделать в два раза больше.
Чтобы вывести параметры транзистора рядом с компонентом (как на рисунке 1.4),
необходимо настроить видимость параметров компонента: при зажатой клавише Ctrl
щелкнуть правой кнопкой мыши на компоненте и отметить столбец Visible для поля
Value2.

Для источника питания инвертора VDD1 задайте постоянное значение напряже-
ния 1 В. Для источника напряжения V1 задайте параметры, как показано на рисун-
ке 1.5 (для этого в окне параметров необходимо нажать кнопку Advanced). Источник
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V1 генерирует прямоугольные импульсы (чередование «0» и «1»), которые будут
поданы на вход инвертора для его тестирования. Заметьте, что буквы после чисел
обозначают приставки кратных и дольных величин в системе СИ (k – кило-, n –
нано-, p – пико-, f – фемто- и т.д.).

Рисунок 1.5 – Окно настроек источника напряжения

Добавьте на схему настройки анализа переходного процесса (Edit → SPICE
Analysis) с параметрами, как показано на рисунке 1.6. Настройки задают время мо-
делирования 8 нс и шаг моделирования 1 пс.

Рисунок 1.6 – Окно настроек процедуры анализа переходного процесса

15



Запустите симуляцию (Simulate → Run). Появится окно для вывода временных
диаграмм. Наведите курсор мыши на провод перед инвертором; курсор примет вид
щупа осциллографа. Щелкните на проводе, чтобы добавить временную диаграмму
входного напряжения инвертора на график. Аналогично добавьте диаграмму выход-
ного напряжения. График должен иметь вид, как на рисунке 1.7. Выходное напря-
жение инвертора противоположно входному, а значит, инвертор работает корректно.

Рисунок 1.7 – Результаты моделирования переходного процесса в инверторе

1.3.5 Создание иерархических элементов

Для разработки более сложных схем удобно будет иметь готовый инвертор в биб-
лиотеке и вставлять его в новые схемы как иерархический элемент.

Для создания библиотечного элемента требуется создать схему (File → New
Schematic) и символ (File → New Symbol) с одинаковыми именами, например, inverter.

Постройте схему инвертора, как показано на рисунке 1.8.

Рисунок 1.8 – Схема инвертора

16



На схему помещены именованные порты ввода и вывода с помощью Edit → Label
Net и выбора типа порта.

Теперь приступим к созданию символа элемента (File → New Symbol). В качестве
символов элементов следует использовать общепринятые обозначения элементов по
стандартам ГОСТ, IEC или ANSI. Нарисуйте ANSI-символ инвертора, как показано
на рисунке 1.9. Для рисования используйте команды из меню Draw. Добавьте в сим-
вол порты (Edit → Add Pin/Port) с такими же названиями, как и в схеме элемента.
Для порта выберите, надо ли отображать название, и если да, то с какой стороны от
него будет отображаться точка электрического соединения.

Рисунок 1.9 – Символ инвертора

Теперь инвертор можно вставлять в новые схемы как библиотечный элемент. По-
стройте схему тестирования инвертора с применением иерархического символа (ри-
сунок 1.10). Промоделируйте схему. Результаты должны совпасть с результатами
моделирования предыдущей схемы.

Рисунок 1.10 – Схема тестирования инвертора с использованием разработанного
символа

Настроим отображение сигналов на разных координатных сетках. Щелкните пра-
вой кнопкой мыши на окне временной диаграммы и выберите пункт Add plot pane
(рисунок 1.11). На диаграмме появится пустое поле, на которое необходимо пере-
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тащить один из двух сигналов. Для этого, щелкнув по окну правой кнопкой, надо
выбрать из контекстного меню пункт Edit → Move и выделить курсором в окне
диаграммы прямоугольную область, включающую название требуемого сигнала (на-
пример, «V(n001)»). После того как область будет выделена, название сигнала станет
перемещаться вместе с курсором. Щелкните по пустой области диаграммы, чтобы
добавить в нее выбранный сигнал. Для удаления сигнала необходимо выбрать из кон-
текстного меню инструмент Edit → Delete, а затем щелкнуть по названиям ненужных
сигналов или выделить их. В результате должна получиться диаграмма, показанная
на рисунке 1.12. Более подробно об управлении временными диаграммами можно
узнать в справке LTspice.

Рисунок 1.11 – Добавление дополнительной области на временную диаграмму

Рисунок 1.12 – Временная диаграмма с разными областями для отображения
сигналов

Отредактируйте параметры инвертора. Для этого щелкните по символу правой
кнопкой мыши и в строке PARAMS введите «T_SIZE=4». Промоделируйте схему
еще раз. Длительность переходных процессов при переключении инвертора должна
уменьшиться.
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1.4 Основы работы в среде Vivado Design Suite

В данном разделе описаны принципы работы в системе автоматизированного
проектирования (САПР) Vivado Design Suite (далее Vivado) фирмы Xilinx. Версия
WebPACK является бесплатной и доступна для скачивания с официального сайта
Xilinx (https://www.xilinx.com/).

Vivado предназначена для проектирования программного обеспечения микросхем
программируемой логики (ПЛИС) фирмы Xilinx. В разделе описан пример проекти-
рования в Vivado версии 2017.4. Описанные рекомендации также применимы и для
более ранних и поздних версий с учетом небольших различий версий в элементах
пользовательского интерфейса.

1.4.1 Схема сумматора

Чтобы ознакомиться с принципами проектирования цифровых схем в Vivado, раз-
берем пример построения схемы неполного одноразрядного сумматора. Таблица ис-
тинности рассматриваемой схемы сумматора представлена в таблице 1.1.

Таблица 1.1 – Таблица истинности неполного одноразрядного сумматора

a b c
0 0 0
0 1 1
1 0 1
1 1 0

Построим данную схему в базисе И-НЕ. Для этого сначала запишем совершенную
дизъюнктивную нормальную форму (СДНФ) функции сумматора:

𝑎+ 𝑏 = 𝑎 · 𝑏 ∨ 𝑎 · 𝑏. (1.1)

Возьмем двойное отрицание и преобразуем СДНФ по правилам де Моргана:

𝑎 · 𝑏 ∨ 𝑎 · 𝑏 = 𝑎 · 𝑏 · 𝑎 · 𝑏 (1.2)

В итоге для выполнения суммирования двух одноразрядных чисел нам понадо-
бится 5 двухвходовых элементов И-НЕ. Схема сумматора на И-НЕ представлена на
рисунке 1.13.
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Рисунок 1.13 – Схема сумматора в базисе И-НЕ

1.4.2 Описание схемы сумматора на вентильном уровне с ис-

пользованием языка Verilog HDL

Рассмотрим пример описания схемы, изображенной на рисунке 1.13, на языке
Verilog HDL, а также пример описания тестового окружения для этой схемы.

В данном разделе мы будем описывать схему на вентильном уровне, то есть ис-
пользуя только примитивы вентилей, доступные в Verilog HDL.

Дадим всем линиям схемы обозначения, которые затем будем использовать в тек-
стовом описании схемы. Аннотированная схема представлена на рисунке 1.14.

Рисунок 1.14 – Аннотированная схема сумматора в базисе И-НЕ

Полное описание модуля, реализующего функциональность схемы на Verilog HDL,
представлено в листинге 1.1.

Модуль является базовой единицей схемы в Verilog HDL. Вся логика и структура
схемы описываются внутри модулей. Модули могут входить в состав других модулей,
образуя при этом иерархическую структуру целевого устройства. Модули в Verilog
обрамляются ключевыми словами module и endmodule в начале и конце соответ-
ственно. Рекомендуется описывать каждый модуль в виде отдельного файла, хотя
это не является обязательным.
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Листинг 1.1 – Описание модуля сумматора на Verilog HDL

‘timescale 1ns / 1ps

module adder (

input a ,

input b ,

output c

) ;

wire not_a , not_b , y1 , y2 ;

nand( not_a , a , a ) ;

nand(not_b , b , b) ;

nand( y1 , not_a , b) ;

nand( y2 , a , not_b) ;

nand( c , y1 , y2 ) ;

endmodule

В самом начале исходного кода располагается директива timescale, которая зада-
ет шаг (1ns) и точность (1ps) продвижения модельного времени. Данная директива не
является обязательной, и, чтобы она работала, необходимо, чтобы она была одинако-
ва во всех файлах проекта. При этом данная настройка может быть переопределена
в настройках симулятора.

После ключевого слова module записывается уникальное имя модуля. В нашем
случае имя модуля – adder. Далее идет определение портов с указанием направления
передачи данных: входной (input) или выходной (output) порт.

По умолчанию тип переменной порта, если он не указан, задается как wire. В
Verilog также существует ещё один синтезируемый тип переменных и портов – это
reg. Когда говорится, что данная конструкция языка синтезируема, то подразумева-
ется, что всё, что описано с помощью таких конструкций, может быть транслировано
в конкретную цифровую схему. Несинтезируемое подмножество языка используется
только для моделирования, например, задания входных и анализа выходных значе-
ний, и не может быть транслировано в элементы цифровой схемы.

Переменные wire используются для описания только комбинационной логики
(схем без памяти). Переменные reg могут быть использованы для описания как ком-
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бинационной, так и последовательностной логики (схем с памятью). При этом тип
reg может быть только у выходных портов.

В разбираемом примере мы используем только элементы комбинационной логики,
поэтому можно ограничиться использованием типа wire. В листинге 1.1 определены
линии not_a, not_b, y1, y2 в соответствии с рисунком 1.14.

Далее следует описание набора вентилей И-НЕ nand. В Verilog доступны для
использования и другие вентили, такие как nor, or, and, not и xor. При описании
вентилей первый аргумент задает связь выходного значения с локальной переменной,
остальные аргументы – это входные значения.

При описании вентилей порядок их задания не имеет значения. Следует пони-
мать, что при таком описании описывается структура взаимосвязей компонентов, а
не последовательность действий.

После того, как модуль сумматора готов, необходимо удостовериться в его ра-
ботоспособности. Для проверки работоспособности создается специальный модуль
тестового окружения, в котором описывается последовательность изменения вход-
ных и анализ выходных значений нашего модуля. Описание тестового окружения
сумматора представлено в листинге 1.2.

Модуль тестового окружения не взаимодействует с внешним миром, поэтому не
имеет портов ввода/вывода. В первой части модуля описано подключение разра-
ботанного модуля сумматора и определено подключение его портов. Порты можно
подключать простым перечислением, а можно с явным указанием имен портов, как
и сделано в приведенном листинге. Второй вариант подключения является более
безопасным, так как изменение порядка следования портов в модуле сумматора не
приведет к ошибке в соединении портов в тестовом окружении.

Переменные, задающие входные значения, имеют тип reg, так как мы должны
иметь возможность удерживать тестовые значения на входах модуля, чтобы про-
анализировать его выход. Условно можно считать, что входные порты сумматора
подключаются к регистрам, значения которых мы будем менять в процессе модели-
рования. Переменная, к которой подключается выходной порт модуля, может иметь
только тип wire.

Последовательность изменения входных значений задается в процедурном блоке
initial. Он вызывается в самом начале процесса моделирования и после выполнения
всех действий повторно не выполняется. Если определено несколько блоков initial,
то их выполнение начинается одновременно и идет параллельно, и невозможно пред-
сказать точную последовательность действий, привязанных к одному и тому же мо-
менту времени.
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Листинг 1.2 – Описание модуля тестового окружения сумматора на Verilog HDL

‘timescale 1ns / 1ps

module adder_tb ;

reg a_in , b_in ;

wire c_out ;

adder adder_1 (

. a ( a_in ) ,

. b ( b_in ) ,

. c ( c_out )

) ;

integer i ;

reg [ 1 : 0 ] t e s t_va l ;

reg expected_val ;

i n i t i a l begin

for ( i = 0 ; i < 4 ; i = i +1) begin

te s t_va l = i ;

a_in = test_va l [ 0 ] ;

b_in = test_va l [ 1 ] ;

expected_val = ^test_va l ;

#10

i f ( c_out == expected_val ) begin

$display ( "The␣adder ␣output␣ i s ␣ c o r r e c t ! ! ! ␣a_in=%b ,

␣b_in=%b␣c_out␣=␣%b" , a_in , b_in , c_out ) ;

end else begin

$display ( "The␣adder ␣output␣ i s ␣wrong ! ! ! ␣a_in=%b , ␣

b_in=%b␣c_out␣=␣%b , ␣ expected ␣%b" , a_in , b_in ,

c_out , expected_val ) ;

end

end

#10 $stop ;

end

endmodule
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Если процедурный блок initial описывает выполнение последовательности дей-
ствий, то эта последовательность должна быть обрамлена ключевыми словами begin

и end. Это верно для всех процедурных блоков.
Продвижение модельного времени осуществляется с помощью явного указания

задержек, предваряемых символом #. По умолчанию задержки указываются в на-
носекундах (нс). Это может быть переопределено с помощью директивы timescale

или с помощью настроек симулятора.
В листинге 1.2 в теле блока for задается последовательность изменения входных

значений и производится анализ выходных. Результат анализа выходных значений
печатается в консоль симулятора с помощью встроенной функции $display. Встро-
енные функции в Verilog предваряются символом доллара $. В конце блока initial

вызывается функция $stop, которая останавливает моделирование.

1.4.3 Создание проекта в Vivado Design Suite

Создадим в Vivado проект для схемы сумматора, описанной в предыдущих раз-
делах. Для запуска Vivado находим соответствующий значок на рабочем столе (ри-
сунок 1.15) и щелкаем два раза.

Рисунок 1.15 – Иконка программного комплекса Vivado

В открывшемся окружении выбираем File → New Project (рисунок 1.16). В от-
крывшемся окне нажимаем Next (рисунок 1.17). Задаем имя проекта и нажимаем
Next (рисунок 1.18). Выбираем RTL Project и нажимаем Next (рисунок 1.19).

В качестве микросхемы программируемой логики, под которую будет вестись
разработка устройства, выбираем XC7A100TCSG324-1 и нажимаем Next (рису-
нок 1.20). Данная микросхема установлена в отладочной плате Nexys A7 (https:
//store.digilentinc.com/nexys-a7-fpga-trainer-board-recommended-for-ece-curriculum/),
которая будет в дальнейшем использоваться в работах.

В последнем диалоговом окне нажимаем кнопку Finish (рисунок 1.21). После
создания проекта откроется окружение, показанное на рисунке 1.22.
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Рисунок 1.16 – Пункт меню создания нового проекта

Рисунок 1.17 – Диалоговое окно создания нового проекта
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Рисунок 1.18 – Окно ввода имени проекта

Рисунок 1.19 – Окно выбора типа проекта
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Рисунок 1.20 – Окно выбора целевой микросхемы программируемой логики

Рисунок 1.21 – Окно с информацией о создаваемом проекте и кнопкой завершения
создания нового проекта
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Для добавления новых исходных файлов нажимаем на Add Sources в левом верх-
нем углу рабочего окружения (подчеркнуто красным на рисунке 1.22).

Рисунок 1.22 – Кнопка для добавления исходных файлов в проект

В открывшемся окне выбираем Add or create design sources и нажимаем Next
(рисунок 1.23).

Рисунок 1.23 – Окно выбора типа добавляемых исходных файлов

В открывшемся окне выбираем Create File и задаем имя файлу, в котором будем
описывать функциональность сумматора (рисунок 1.24).
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Рисунок 1.24 – Окно с полем ввода имени для создаваемого проектного файла

Нажимаем Next и переходим к описанию портов модуля (рисунок 1.25). Данный
шаг можно пропустить, нажав OK, и явно определить интерфейс модуля в файле
модуля.

Рисунок 1.25 – Окно для создания портов ввода/вывода нового модуля

После создания нового файла он откроется для редактирования (рисунок 1.26).
Добавим описание модуля (рисунок 1.27).
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Теперь у нас есть проект и описание модуля сумматора. Далее необходимо создать
тестовое окружение для разработанного модуля.

Рисунок 1.26 – Вид в редакторе содержимого файла модуля после создания

Рисунок 1.27 – Вид в редакторе целевого описания модуля
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1.4.4 Моделирование схемы

Для создания файла тестового окружения вновь нажимаем на Add Sources в ле-
вом верхнем углу рабочего окружения (подчеркнуто красным на рисунке 1.22). Те-
перь выбираем Add or create simulation sources (рисунок 1.28).

Рисунок 1.28 – Окно добавления файлов для окружения тестирования

В открывшемся окне выбираем Create File и задаем имя файлу, в котором будем
описывать функциональность тестового окружения сумматора (рисунок 1.29).

Рисунок 1.29 – Окно ввода имени файла тестового окружения
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После создания файла тестового окружения, наполняем его (рисунок 1.30).

Рисунок 1.30 – Вид в редакторе содержимого файла тестового окружения

Для запуска тестового окружения на выполнение необходимо в левой панели
выбрать Run Simulation и в открывшемся выпадающем меню - Run Behavioural
Simulation (рисунок 1.31).

Рисунок 1.31 – Кнопка для запуска моделирования на поведенческом уровне
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После запуска процесс моделирования остановится на моменте вызова функции
$stop. Для просмотра результатов моделирования необходимо переключиться на
вкладку с названием, начинающимся с Untitled (рисунок 1.32).

Рисунок 1.32 – Вкладка с результатами моделирования

По умолчанию временная диаграмма имеет масштаб, который не позволяет про-
смотреть весь процесс моделирования. Чтобы увидеть полную диаграмму, необходи-
мо нажать на кнопку Zoom Fit (рисунок 1.33).

Рисунок 1.33 – Кнопка для просмотра полной временной диаграммы

На рисунке 1.34 представлена временная диаграмма всего процесса моделирова-
ния. Можно видеть все комбинации входных сигналов, значение выходного сигнала,
а также вывод результатов анализа выходного значения схемы в консоли симулятора.

Стоит отметить, что при проведении описанного выше поведенческого модели-
рования схемы никак не учитываются задержки распространения сигналов через
вентили.

33



Рисунок 1.34 – Окно с результатами моделирования схемы
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2 Лабораторная работа №2. Разработка аппаратных

ускорителей математических вычислений

2.1 Введение

Лабораторная работа №2 посвящена разработке цифровых схем ускорителей ма-
тематических операций на уровне регистровых передач (register transfer level, RTL)
с использованием языка описания аппаратуры Verilog HDL.

В работе предлагается разработать цифровой блок со сложной логикой работы
для выполнения заданной вариантом арифметической операции. Разработка должна
осуществляться с учетом установленных ограничений на формат входных и выход-
ных данных, а также на использование базовых арифметических блоков сложения и
умножения.

В процессе реализации алгоритма работы разрабатываемого блока развиваются
навыки проектирования цифровых схем конечных автоматов. Конечные автоматы
используются для реализации управляющей логики блока и синхронизации шагов
вычислительного процесса.

2.2 Описание лабораторной работы

Цель работы

Получить навыки описания арифметических блоков на RTL-уровне с использо-
ванием языка описания аппаратуры Verilog HDL.

Указания к выполнению работы

Лабораторная работа посвящена знакомству с техниками описания схем арифме-
тических блоков на RTL-уровне с использованием языка Verilog HDL. Работа выпол-
няется в Vivado Design Suite.

Порядок выполнения работы

1. Разработайте и опишите на Verilog HDL схему, вычисляющую значение функ-
ции в соответствии с заданными ограничениями согласно варианту задания.

2. Определите область допустимых значений функции.
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3. Разработайте тестовое окружение для разработанной схемы. Тестовое окруже-
ние должно проверять работу схемы не менее, чем на 10 различных тестовых
векторах.

4. Проведите моделирование работы схемы и определите время вычисления ре-
зультата. Схема должна тактироваться от сигнала с частотой 100 МГц.

5. Составьте отчет по результатам выполнения работы.

Требования к отчету

Отчет должен быть оформлен в соответствии с требованиями, представленными
в Приложении A.

Отчет должен включать:

1. Титульный лист.

2. Цель работы.

3. Задание в соответствии с вариантом.

4. Схему (рисунок) разработанного блока вычисления функции, заданной вариан-
том, в терминах базовых операционных элементов (БОЭ) (т.е. используя муль-
типлексоры/демультиплексоры, шифраторы/дешифраторы, компараторы, ре-
гистры, счетчики и др.).

5. Описание работы разработанного блока, начиная с подачи входных данных и
заканчивая получением результата.

6. Область допустимых значений для разработанного блока.

7. Результат тестирования разработанного блока (временные диаграммы).

8. Время вычисления результата при частоте тактового сигнала в 100 МГц.

9. Выводы по работе.
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Задания по вариантам

Вариант Функция Ограничения

1 𝑦 = 𝑎2 + 3
√
𝑏 1 cумматор и 2 умножителя

2 𝑦 = 𝑎3 + 2
√
𝑏 2 сумматора и 1 умножитель

3 𝑦 =
√
𝑎2 + 𝑏2 1 cумматор и 2 умножителя

4 𝑦 =
√︀

𝑎+ 3
√
𝑏 2 сумматора и 1 умножитель

5 𝑦 = 3𝑎+ 2 · 3
√
𝑏 1 cумматор и 2 умножителя

6 𝑦 = 𝑎 · 𝑏+ 𝑎3 2 cумматора и 1 умножитель

7 𝑦 = 𝑎 ·
√
𝑏 2 cумматора и 2 умножителя

8 𝑦 = 𝑎 · 3
√
𝑏 1 cумматор и 2 умножителя

9 𝑦 = 3
√
𝑎+

√
𝑏 2 cумматора и 1 умножитель

10 𝑦 =
3
√︀
𝑎+ 2

√
𝑏 2 cумматора и 2 умножителя

Комментарии к заданиям

В качестве входных данных необходимо использовать целые беззнаковые числа с
разрядностью 8 бит.

Разрядность выходного значения выбирается в соотвествии с областью допусти-
мых значений функции. Результат вычислений не должен выходить за границы фор-
мата представления выходного значения блока.
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Ограничения накладываются на количество используемых блоков суммирования
и умножения. В разработанной схеме должен быть использован блок умножения, ре-
ализующий последовательный алгоритм умножения «в столбик». В качестве основы
можно взять реализацию, представленную в разделе 2.4.1.

Сумматор реализуется с помощью встроенного в Verilog оператора суммы «+».
Сдвиги реализуются с помощью встроенных операторов сдвига «<<» и «>>».

Для вычисления квадратного и кубического корней могут использоваться алго-
ритмы, представленные в разделе 2.4.

При выполнении заданий необходимо использовать беззнаковую целочисленную
арифметику.

2.3 Разработка цифровых схем конечных автоматов

Конечные автоматы в цифровой схемотехнике используются для реализации ло-
гики управления функциональных блоков. С помощью конечных автоматов зада-
ется алгоритм работы функционального блока посредством определения состояний
в алгоритме управления и условий переходов между состояниями. Автоматы реа-
лизуются в виде цифровых аппаратных блоков и выполняют функции устройства
управления в составе функциональных узлов схемы.

Существует множество видов конечных автоматов. На практике для реализации
функциональности блоков управления чаще всего используют либо автомат Мура,
либо автомат Мили.

Обобщенная структурная схема автомата Мура представлена на рисунке 2.1.

Рисунок 2.1 – Обобщенная схема автомата Мура

Из схемы видно, что выходное значение автомата зависит только от текущего
состояния автомата и не зависит напрямую от входных значений. Работа автомата
синхронизируется по тактовому сигналу clk. На каждом такте clk происходит запись
нового состояния state_next в регистр состояния. «Логика формирования следую-
щего состояния» и «логика формирования выходного значения» являются комбина-
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ционными схемами, то есть не имеют памяти – их выход изменяется при изменении
входных сигналов.

Пример графа переходов автомата Мура представлен на рисунке 2.2.

Рисунок 2.2 – Пример графа переходов автомата Мура

В графе кружками обозначаются состояния, а дугами – переходы. Переход осу-
ществляется, если значение входа автомата равно значению, указанному над дугой.
В представленном примере вход автомата на каждом такте работы может принимать
одно значение из множества {𝑥0, 𝑥1, 𝑥2, 𝑥3}.

Начальным состоянием является 𝑆0. В него автомат переходит из любого состо-
яния при активном значении сигнала сброса rst и формирует на выходе значение 𝑦0.

Пример таблицы переходов автомата Мура представлен в таблице 2.1.

Таблица 2.1 – Пример таблицы переходов автомата Мура

S/rst,X rst 𝑥0 𝑥1 𝑥2 𝑥3

𝑆0 𝑆0/𝑦0 𝑆1/𝑦1 𝑆0/𝑦0 𝑆0/𝑦0 𝑆0/𝑦0
𝑆1 𝑆0/𝑦0 𝑆1/𝑦1 𝑆2/𝑦2 𝑆1/𝑦1 𝑆1/𝑦1
𝑆2 𝑆0/𝑦0 𝑆2/𝑦2 𝑆2/𝑦2 𝑆1/𝑦1 𝑆0/𝑦0

В первой строке таблицы перечислены значения входа автомата, включая ситу-
ацию подачи сигнала сброса rst на автомат, а в первой колонке перечислены воз-
можные состояния. В ячейках таблицы указаны значения следующего состояния и
выхода автомата при условии, что в данном состоянии на вход автомата было пе-
редано соответствующее значение. Например, если автомат находился в состоянии
𝑆0 и ему на вход было передано 𝑥0, то он перейдет в состояние 𝑆1 и сформирует
на выходе значение 𝑦1. Это обозначено в таблице как ячейка 𝑆1/𝑦1 на пересечении
столбца 𝑥0 и строки 𝑆0.

Реализация автомата Мура на языке Verilog HDL представлена в листинге 2.1.
В листинге явно выделены структурные части, обозначенные на рисунке 2.1. На
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практике возможно объединение разных структурных частей в рамках одних и тех
же процедурных блоков.

Листинг 2.1 – Описание автомата Мура на Verilog HDL

module moore (

input wire c lk ,

input wire r s t ,

input wire [ 1 : 0 ] x ,

output wire [ 1 : 0 ] y

) ;

localparam S0 = 0 , S1 = 1 , S2 = 2 ;

localparam X0 = 0 , X1 = 1 , X2 = 2 , X3 = 3 ;

reg [ 1 : 0 ] s t a t e ;

reg [ 1 : 0 ] state_next ;

// логика формирования следующего состояния

always @*
case ( s t a t e )

S0 : state_next = (x == X0) ? S1 : S0 ;

S1 : state_next = (x == X1) ? S2 : S1 ;

S2 : state_next = (x == X2) ? S1 :

( x == X3) ? S0 : S2 ;

default : state_next = s t a t e ;

endcase

// логика формирования выходного значения

assign y = s t a t e ;

// регистр состояния

always @(posedge c l k )

i f ( r s t ) begin

s t a t e <= S0 ;

end else begin

s t a t e <= state_next ;

end

endmodule
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Обобщенная структурная схема автомата Мили представлена на рисунке 2.3.

Рисунок 2.3 – Обобщенная схема автомата Мили

В автомате Мили выходное значение автомата зависит не только от текущего со-
стояния, но и от входных значений. Пример графа переходов автомата Мили пред-
ставлен на рисунке 2.4.

Рисунок 2.4 – Пример графа переходов автомата Мили

Каждый переход автомата Мили аннотируется значением, которое автомат фор-
мирует на выходе. Например, переход из состояния 𝑆0 в 𝑆1 происходит, если на вход
автомата подано значение 𝑥0. При этом на выходе формируется значение 𝑦1. Если
же автомат переходит из состояния 𝑆2 в состояние 𝑆1 при наличии на входе 𝑥2, то
на выходе формируется значение 𝑦3. Таким образом, в одном и том же состоянии 𝑆1

автомат может иметь два разных значения на выходе, а именно 𝑦1 или 𝑦3.
Пример таблицы переходов автомата Мили представлен в таблице 2.2. 𝑦𝑝𝑟𝑒𝑣 –

это значение выхода автомата на предыдущем шаге в соответствующем состоянии.
Таким образом, в автомате Мили невозможно узнать выходное значение только по
текущему состоянию автомата.

Реализация автомата Мили на языке Verilog HDL представлена в листинге 2.2.
В листинге явно выделены структурные части, обозначенные на рисунке 2.3. На
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практике возможно объединение разных структурных частей в рамках одних и тех
же процедурных блоков.

Таблица 2.2 – Пример таблицы переходов автомата Мили

S/rst,X rst 𝑥0 𝑥1 𝑥2 𝑥3

𝑆0 𝑆0/𝑦0 𝑆1/𝑦1 𝑆0/𝑦𝑝𝑟𝑒𝑣 𝑆0/𝑦𝑝𝑟𝑒𝑣 𝑆0/𝑦𝑝𝑟𝑒𝑣
𝑆1 𝑆0/𝑦0 𝑆1/𝑦𝑝𝑟𝑒𝑣 𝑆2/𝑦2 𝑆1/𝑦𝑝𝑟𝑒𝑣 𝑆1/𝑦𝑝𝑟𝑒𝑣
𝑆2 𝑆0/𝑦0 𝑆2/𝑦𝑝𝑟𝑒𝑣 𝑆2/𝑦𝑝𝑟𝑒𝑣 𝑆1/𝑦3 𝑆0/𝑦4

Листинг 2.2 – Описание автомата Мили на Verilog HDL

module mealy (

input wire c lk ,

input wire r s t ,

input wire [ 1 : 0 ] x ,

output reg [ 2 : 0 ] y

) ;

localparam S0 = 0 , S1 = 1 , S2 = 2 ;

localparam X0 = 0 , X1 = 1 , X2 = 2 , X3 = 3 ;

localparam Y0 = 0 , Y1 = 1 , Y2 = 2 ,

Y3 = 3 , Y4 = 4 ;

reg [ 1 : 0 ] s t a t e ;

reg [ 1 : 0 ] state_next ;

reg [ 2 : 0 ] y_next ;

// логика формирования следующего состояния

always @*
case ( s t a t e )

S0 : state_next = (x == X0) ? S1 : S0 ;

S1 : state_next = (x == X1) ? S2 : S1 ;

S2 : state_next = (x == X2) ? S1 :

( x == X3) ? S0 : S2 ;

default : state_next = s t a t e ;

endcase
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// логика формирования выходного значения

always @* begin

y_next = y ;

case ( s t a t e )

S0 : i f ( x == X0) y_next = Y1 ;

S1 : i f ( x == X1) y_next = Y2 ;

S2 : begin

i f ( x == X2) y_next = Y3 ;

i f ( x == X3) y_next = Y4 ;

end

default : y_next = y ;

endcase

end

// регистр выходного порта y

always @(posedge c l k )

i f ( r s t ) begin

y <= Y0 ;

end else begin

y <= y_next ;

end

// регистр состояния

always @(posedge c l k )

i f ( r s t ) begin

s t a t e <= S0 ;

end else begin

s t a t e <= state_next ;

end

endmodule

Автомат Мили может быть однозначно преобразован в автомат Мура, и наоборот.
На рисунке 2.5 представлен граф переходов автомата Мура, реализующий функци-
ональность автомата Мили, изображенного на рисунке 2.4. Таблица переходов полу-
чившегося автомата Мура представлена в таблице 2.3.

Как видно из рисунка 2.5, чтобы избежать неоднозначности в определении вы-
хода, исходные состояния 𝑆0 и 𝑆1 были разбиты на два: 𝑆0.1, 𝑆0.2 и 𝑆1.1, 𝑆1.2
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Рисунок 2.5 – Граф переходов автомата Мура, эквивалентного автомату Мили,
представленному на рисунке 2.4

Таблица 2.3 – Таблица переходов автомата Мура, эквивалентного автомату Мили,
представленному на рисунке 2.4

S/rst,X rst 𝑥0 𝑥1 𝑥2 𝑥3

𝑆0.1 𝑆0.1/𝑦0 𝑆1.1/𝑦1 𝑆0.1/𝑦0 𝑆0.1/𝑦0 𝑆0.1/𝑦0
𝑆0.2 𝑆0.1/𝑦0 𝑆1.1/𝑦1 𝑆0.2/𝑦4 𝑆0.2/𝑦4 𝑆0.2/𝑦4
𝑆1.1 𝑆0.1/𝑦0 𝑆1.1/𝑦1 𝑆2/𝑦2 𝑆1.1/𝑦1 𝑆1.1/𝑦1
𝑆1.2 𝑆0.1/𝑦0 𝑆1.2/𝑦3 𝑆2/𝑦2 𝑆1.2/𝑦3 𝑆1.2/𝑦3
𝑆2 𝑆0.1/𝑦0 𝑆2/𝑦2 𝑆2/𝑦2 𝑆1.2/𝑦3 𝑆0.2/𝑦4

соответственно. Теперь выходное значение автомата полностью определяется его со-
стоянием, как показано в таблице 2.3.

Таким образом, граф переходов автомата Мили имеет более компактный вид по
сравнению с графом автомата Мура, но вместе с этим более сложную логику фор-
мирования выходного значения, так как необходимо учитывать не только текущее
состояние автомата, но и значение его входа.
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2.4 Алгоритмы машинной арифметики

В цифровой технике более сложные арифметические операции, такие как умноже-
ние, деление, извлечение корня и др., сводятся к более простым (сложению, вычита-
нию и сдвигу) и реализуются с помощью базовых операционных элементов цифровой
схемотехники.

В данном разделе будут рассмотрены алгоритмы умножения, извлечения квад-
ратного и кубического корней. Понимание данных алгоритмов будет необходимо для
успешного выполнения задания лабораторной работы. Для алгоритма умножения
будет приведен пример его реализации в виде аппаратного блока.

2.4.1 Алгоритм умножения

Рассмотрим алгоритм умножения «в столбик». Пример умножения двух 4-
разрядных беззнаковых чисел приведен на рисунке 2.6.

Рисунок 2.6 – Пример умножения «в столбик»

В примере перемножаются числа 10112 = 1110 и 01102 = 610. Произведение по-
лучилось равным 10000102 = 6610. В процессе вычисления результата выполнялось
умножение каждого разряда второго операнда на первый операнд и сложение част-
ных результатов. Умножение на 0 и 1 выполняется простейшим образом: разряды
второго операнда можно рассматривать как условие, определяющее необходимость
сложения первого операнда с полученным на предыдущих шагах частным результа-
том. Каждое сложение выполняется со сдвигом на один разряд относительно преды-
дущего шага.
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Важно, что для сохранения результата требуется отводить регистр, имеющий раз-
рядность вдвое большую, чем разрядность операндов. Это необходимо, чтобы избе-
жать переполнения формата и получения неверного результата.

Схема алгоритм умножения «в столбик» представлена на рисунке 2.7.

Рисунок 2.7 – Схема алгоритма умножения «в столбик»

На рисунке 2.7 символом N обозначена разрядность операндов a и b. Частная
сумма на каждом шаге помещается в переменную part_res. Переменная ctr исполь-
зуется как счетчик шагов алгоритма. С помощью b[ctr] обозначается выборка бита с
номером ctr из второго операнда b. Нумерация битов начинается с 0. В конце расчета
результат помещается в переменную result.

Теперь спроектируем аппаратный блок умножения. Сначала определим интер-
фейс блока. Так как вычисления выполняются за несколько шагов, то необходим
сигнал, по которому блок должен начать вычисления (start_i), сигнал, определяю-
щий занятость блока вычислениями (busy_o), а также сигнал сброса (rst_i) и так-
товый сигнал (clk_i). Тактовый сигнал или сигнал синхронизации необходим для
реализации пошагового алгоритма – каждый шаг будет выполняться с приходом
очередного положительного фронта тактового сигнала. Помимо этого, понадобят-
ся входные шины данных для передачи значений операндов (a_bi и b_bi) к блоку,
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а также одна выходная шина (y_bo) для передачи результатов вычислений. Для
примера примем, что операнды представлены беззнаковыми 8-разрядными целыми
числами. Выходная шина данных при этом будет иметь разрядность в 16 бит, то
есть вдвое большую, чем разрядность операндов. Интерфейс проектируемого блока
представлен на рисунке 2.8.

Рисунок 2.8 – Интерфейс аппаратного блока умножения

Устройство управления ходом вычислительного процесса удобно выполнить как
конечный автомат Мили, граф переходов которого представлен на рисунке 2.9.

Рисунок 2.9 – Граф переходов автомата устройства управления блока умножения

Управляющий автомат имеет два состояния: ожидание (IDLE) и работа (WORK).
В состоянии IDLE блок ожидает прихода управляющего сигнала start_i и переходит
к началу вычислений. Все шаги алгоритма реализуются в состоянии WORK.

В представленном графе над каждым переходом указано условие перехода и че-
рез косую черту значение выходных сигналов y_bo и busy_o. Так, например, пе-
реход из состояния IDLE в состояние WORK производится по выполнению условия
(start_i == 1). На выходе y_bo при этом сохраняется предыдущее значение, а сигнал
busy_o принимает значение 1.

Реализация алгоритма умножения «в столбик» на языке Verilog HDL представ-
лена в листинге 2.3. В представленном описании логика формирования следующего
состояния, регистр состояния и логика формирования выходных значений автомата
Мили объединены в один процедурный блок.
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Листинг 2.3 – Описание блока умножения на Verilog HDL

module mult (

input clk_i ,

input rst_i ,

input [ 7 : 0 ] a_bi ,

input [ 7 : 0 ] b_bi ,

input s tart_i ,

output busy_o ,

output reg [ 1 5 : 0 ] y_bo

) ;

localparam IDLE = 1 ’ b0 ;

localparam WORK = 1 ’ b1 ;

reg [ 2 : 0 ] c t r ;

wire [ 2 : 0 ] end_step ;

wire [ 7 : 0 ] part_sum ;

wire [ 1 5 : 0 ] shifted_part_sum ;

reg [ 7 : 0 ] a , b ;

reg [ 1 5 : 0 ] part_res ;

reg s t a t e ;

assign part_sum = a & {8{b [ c t r ] } } ;

assign shifted_part_sum = part_sum << ct r ;

assign end_step = ( c t r == 3 ’ h7 ) ;

assign busy_o = s t a t e ;

always @(posedge c lk_i )

i f ( r s t_i ) begin

c t r <= 0 ;

part_res <= 0 ;

y_bo <= 0 ;

s t a t e <= IDLE ;

end else begin
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case ( s t a t e )

IDLE :

i f ( s t a r t_ i ) begin

s t a t e <= WORK;

a <= a_bi ;

b <= b_bi ;

c t r <= 0 ;

part_res <= 0 ;

end

WORK:

begin

i f ( end_step ) begin

s t a t e <= IDLE ;

y_bo <= part_res ;

end

part_res <= part_res + shifted_part_sum ;

c t r <= c t r + 1 ;

end

endcase

end

endmodule

2.4.2 Алгоритм извлечения квадратного корня

В данном разделе представлен целочисленный алгоритм извлечения квадратного
корня с округлением до ближайшего меньшего целого числа.

𝑦 = ⌊
√
𝑥⌋

Округление до ближайшего меньшего числа означает, что если мы извлекаем
квадратный корень из числа, для которого квадратный корень не является целым,
то в качестве результата берется наименьшая целая часть. Например, при извлечении
квадратного корня из 10 получим 3,16, и в качестве результата берем 3.

⌊
√
10⌋ = ⌊3,16⌋ = 3
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Схема алгоритма вычисления квадратного корня с использованием только опера-
ций сложения, вычитания, сравнения и сдвига представлена на рисунке 2.10. В схеме
алгоритма символом N обозначена разрядность входного операнда x.

Рисунок 2.10 – Схема алгоритма вычисления квадратного корня
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2.4.3 Алгоритм извлечения кубического корня

В данном разделе представлен целочисленный алгоритм извлечения кубического
корня с округлением до ближайшего меньшего целого числа.

𝑦 = ⌊ 3
√
𝑥⌋

Схема алгоритма вычисления кубического корня с использованием только опера-
ций умножения, сложения, вычитания, сравнения и сдвига представлена на рисун-
ке 2.11. В схеме алгоритма символом N обозначена разрядность входного операнда x.

Рисунок 2.11 – Схема алгоритма вычисления кубического корня
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3 Лабораторная работа №3. Проектирование цифро-

вых схем с использованием ПЛИС

3.1 Введение

Лабораторная работа №3 посвящена получению навыков прототипирования циф-
ровых устройств с использованием микросхем программируемой логики (ПЛИС).

В работе предлагается запустить цифровой блок ускорения математических опе-
раций, разработанный в лабораторной работе №2, на отладочной плате Nexys 4 DDR
с ПЛИС XC7A100T-1CSG324C. Для успешного запуска проект должен быть написан
на синтезируемом подмножестве языка Verilog HDL и содержать корректные описа-
ния базовых операционных элементов цифровой схемотехники.

В процессе выполнения студенты учатся связывать проект с реальным внешним
окружением посредством подключения портов ввода/вывода проекта к реальным
ножкам микросхемы ПЛИС. Таким образом, студенты получают базовые навыки ра-
боты с дискретными портами ввода/вывода, подключенными к светодиодам, движ-
ковым переключателям и кнопкам на используемой отладочной плате.

3.2 Описание лабораторной работы

Цель работы

Получить навыки разработки цифровых устройств на базе программируемых ло-
гических интегральных схем (ПЛИС).

Указания к выполнению работы

Работа выполняется в Vivado Design Suite и с использованием отладочной пла-
ты Nexys 4 DDR (новое название Nexys A7). Пример создания и загрузки файла
конфигурации (прошивки) ПЛИС описан в разделе 3.4.

Порядок выполнения работы

1. Доработайте схему функционального блока, разработанного в лабораторной ра-
боте №2, в соответствии с рисунком 3.1. Необходимо добавить возможность ра-
боты с блоком посредством дискретных портов ввода/вывода, подключенных
к переключателям, светодиодам и кнопкам платы Nexys 4 DDR:
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− значения операндов должны вводиться с помощью переключателей (SW);
− результат должен выводиться на светодиоды (LEDS);
− с целью повышения удобства работы пользователя допускается использо-

вание дополнительных кнопок, переключателей и светодиодов;
− интерфейс пользователя должен обеспечивать возможность многократно-

го проведения вычислений без постоянного нажатия на кнопку сброса.

2. Разработайте тестовое окружение и проведите моделирование.

3. Проведите синтез и размещение схемы для ПЛИС XC7A100T-1CSG324C, вхо-
дящей в состав отладочной платы Nexys 4 DDR.

4. Определите количество и тип используемых ресурсов ПЛИС после размещения
схемы.

5. Проверьте работоспособность схемы на отладочной плате Nexys 4 DDR.

6. Составьте отчет по результатам выполнения работы.

Рисунок 3.1 – Схема сопряжения функционального блока с дискретными портами
ввода/вывода и источником синхросигнала: SW – переключатели, LEDS –

светодиоды, BTN – тактовая кнопка, OSC – генератор синхросигнала
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Требования к отчету

Отчет должен быть оформлен в соответствии с требованиями, представленными
в Приложении A.

Отчет должен включать:

1. Титульный лист.

2. Цель работы.

3. Задание в соответствии с вариантом.

4. Схему (рисунок) сопряжения разработанного блока и устройств ввода/вывода
(переключателей, светодиодов, кнопок и др.). Копирование схемы из задания
не допускается. На схеме должно быть указано актуальное количество исполь-
зуемых устройств ввода/вывода.

5. Описание алгоритма работы пользователя. Приводится схема алгоритма и
краткое описание порядка взаимодействия пользователя с устройством, то есть
указывается, какие кнопки/переключатели в какой последовательности нажи-
мать/переключать, где смотреть и как интерпретировать результат работы.

6. Результат тестирования блока в симуляторе (временные диаграммы).

7. Таблицу с данными об использовании ресурсов ПЛИС.

8. Выводы по работе.

3.3 Архитектура и принцип работы микросхем про-

граммируемой логики

Программируемая логическая интегральная схема (ПЛИС; англ. programmable
logic device, PLD) — это интегральная схема с конфигурируемой логикой работы.

В отличие от обычных цифровых микросхем, логика работы ПЛИС не опре-
деляется при изготовлении, а задаётся посредством программирования. При этом
под программой понимается не последовательность инструкций, которые надо ис-
полнить, а конфигурация реакции внутренних логических элементов на изменения
входных сигналов, а также схема соединений этих элементов.

Для программирования используется специальное аппаратное (программатор)
и программное обеспечение, позволяющее задать желаемую структуру цифрового
устройства в виде схемы или описания на специальных языках описания аппарату-
ры: Verilog, VHDL и др.
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В англоязычной литературе для микросхем ПЛИС существует два различных
термина:

− CPLD (Complex Programmable Logic Device) – разновидность ПЛИС, в которых
конфигуриуются соединения между логическими элементами с уже определен-
ной функциональностью;

− FPGA (Field-Programmable Gate Array) – разновидность ПЛИС, в которых
конфигурируются соединения между логическими элементами и функциональ-
ность самих элементов.

В настоящее время граница между CPLD и FPGA всё больше стирается. Неко-
торые семейства CPLD и FPGA отличаются лишь возможностью хранения конфи-
гурации в энергонезависимой памяти. Микросхемы CPLD обычно содержат меньше
логических элементов, и файл конфигурации занимает меньший объем памяти, чем
конфигурация микросхем FPGA. Поэтому интеграция конфигурационной памяти на
кристалл микросхемы CPLD является не очень затратной по ресурсам, а микросхе-
мы FPGA требуют внешней памяти для хранения своей конфигурации. Возможность
конфигурирования функциональности логических элементов при этом присутству-
ет и там, и там, хотя имеются исключения. Кроме этого, некоторые производители
микросхем FPGA интегрируют на кристалл конфигурационную память для микро-
схем средней емкости. Например, Xilinx так поступала в случае своей линейки FPGA
Spartan-3AN, но это не широко распространенная ситуация.

Далее, говоря о ПЛИС, мы будем подразумевать микросхемы типа FPGA, так
как они чаще используются для реализации сложных цифровых устройств (про-
цессоров, аппаратных ускорителей и пр.). Базовыми элементами микросхем ПЛИС
являются:

− конфигурируемые логические блоки или макроячейки, реализующие требуе-
мую логическую функцию;

− программируемые линии связи между макроячейками;
− программируемые блоки ввода/вывода, обеспечивающие связь вывода микро-

схемы с внешним миром;
− блоки памяти;
− аппаратные IP-ядра (Intellectual Property core, IP-core) – логические блоки или

блоки данных, которые реализуют законченную функциональность (процессор,
Ethernet-контроллер, контроллер PCIe и пр.); также могут быть программиру-
емыми и конфигурируемыми.

Пример структуры микросхемы ПЛИС представлен на рисунке 3.2. На рисунке
представлена ПЛИС с конфигурируемыми макроячейками, встроенным процессор-
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ным ядром, блоками памяти BRAM, DSP-блоками для быстрого выполнения опера-
ций умножения и сложения, высокоскоростными приемопередатчиками.

Аппаратные IP-блоки контроллеров ввода/вывода обычно включаются в более
дорогие устройства ПЛИС. Это позволяет сэкономить ресурсы конфигурируемых
макроячеек и использовать уже готовый блок для организации взаимодействия с
внешними устройствами.

Структурная схема конфигурируемой макроячейки представлена на рисунке 3.3.

Рисунок 3.2 – Пример структуры микросхемы ПЛИС

Внутренняя структура макроячейки определяется фирмой-производителем
ПЛИС и может включать различные компоненты. Можно выделить основные ком-
поненты, присущие большинству видов макроячеек:

− LUT – Look-Up Table (таблица преобразования);
− D-триггер (FF, flip-flop).
С помощью LUT-ячеек реализуется комбинационная логика. Структурная схема

LUT представлена на рисунке 3.4.
LUT представляет собой схему из регистров и мультиплексоров. Входы каждо-

го мультиплексора подключаются к одноразрядным регистрам 𝐷0, 𝐷1, . . . Эти ре-
гистры хранят значения, которые будут поданы на выход при определенной ком-
бинации управляющих сигналов. Входы LUT являются управляющими сигналами
внутренних мультиплексоров. Таким образом, перезаписывая содержимое регистров
𝐷0, 𝐷1, . . ., мы можем менять реакцию LUT на значения входных сигналов и тем
самым реализовывать различные элементы цифровой схемотехники.
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Рисунок 3.3 – Схема конфигурируемой макроячейки

Рисунок 3.4 – Схема внутреннего устройства трехвходового LUT

Пример реализации комбинационной схемы с использованием таблицы LUT пред-
ставлен на рисунке 3.5.

С помощью D-триггеров реализуется последовательностная логика, то есть эле-
менты с памятью: регистры, конечные автоматы, счетчики и др. Однобитовые реги-
стры конфигурации 𝑅1, 𝑅2 необходимы для соединения выхода LUT с триггерами.
Сигналы с этих однобитовых регистров поступают на управляющие входы коммута-
ционных мультиплексоров.
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Разные микросхемы ПЛИС отличаются друг от друга количеством LUT и триг-
геров в макроячейке, а также количеством входов каждого LUT.

Рисунок 3.5 – Пример конфигурации LUT на выполнение функции
комбинационной схемы

На сегодняшний день можно выделить две основные архитектуры ПЛИС: ост-
ровная (island-style или mesh-based FPGA) и иерархическая.

Островная архитектура представлена на рисунке 3.6 и характерна для большин-
ства ПЛИС.

На рисунке 3.6 используются следующие обозначения:
− CLB (Configurable Logic Block) – конфигурируемая макроячейка;
− CB (Connection Box) – это набор программируемых мультиплексоров, подклю-

чающихся непосредственно к входам и выходам блоков CLB, а также портам
ввода/вывода;

− SB (Switch Box) – это набор программируемых мультиплексоров, позволяющих
настроить связь между блоками CB.

Таким образом, блоки CB и SB позволяют настроить соединение конфигурируе-
мых блоков CLB.

В островных ПЛИС все макроячейки равнозначны и соединены одинаковым спо-
собом. Они рассматриваются подобно островам в океане конфигурируемых узлов
коммутации (блоки CB и SB) и линий связи (линии, соединяющие CB и SB). Отсюда
и название – «островная архитектура».
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Рисунок 3.6 – Островная архитектура ПЛИС

Островная архитектура характерна для микросхем фирмы Xilinx, а также се-
мейств Cyclone и Stratix фирмы Intel (бывшая Altera).

Иерархическая архитектура представлена на рисунке 3.7. В ней сделан расчет
на то, что, располагая часто обменивающиеся данными блоки ближе друг к другу,
можно выиграть в количестве используемых ресурсов и производительности систе-
мы. Всё пространство конфигурируемых блоков делится на кластеры (комнаты).
Внутри кластеров конфигурируемые ячейки соединены тесной сетью линий связи и
узлов коммутации, а между кластерами связь организуется с помощью небольшого
количества коммутационных узлов. Таким образом, наилучшая скорость передачи
данных обеспечивается там, где это необходимо, то есть внутри кластеров. А при
организации связи между самими кластерами удается сэкономить ресурсы коммуни-
кационной инфраструктуры.

Иерархическая архитектура характерна для старых семейств Flex10K и APEX
фирмы Intel (бывшая Altera).

Информацию о типе архитектуры ПЛИС можно найти в документации на соот-
ветствующую микросхему. Однако названия блоков одинакового назначения могут
быть разными из-за маркетинговой политики фирм-производителей.
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Рисунок 3.7 – Иерархическая архитектура ПЛИС

3.4 Пример создания и загрузки файла конфигура-

ции ПЛИС в среде Vivado Design Suite

В данном разделе описывается процесс создания файла конфигурации (прошив-
ки) для ПЛИС XC7A100T-1CSG324C, входящей в состав отладочной платы Nexys 4
DDR, а также последующая загрузка файла в устройство с помощью Vivado Design
Suite.

Процесс создания файла конфигурации для ПЛИС в общем случае включает
следующие основные этапы:

− логический синтез;
− отображение схемы на ресурсы ПЛИС, физическое размещение;
− генерация файла.
Иногда весь процесс называют термином «синтез» или «компиляция», но необхо-

димо понимать, что он содержит много шагов, которые нельзя путать. В системах
разных производителей эти шаги могут называться по-разному, но суть остается по-
чти одинаковой.

Перейдем к созданию прошивки. Предполагается, что проект устройства уже со-
здан и отлажен в симуляторе. Следующим шагом является логический синтез схемы,
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в процессе которого описание на языке Verilog HDL переводится в базис логических
примитивов (базовых операционных элементов, вентилей и т.п.).

Для запуска логического синтеза необходимо в левой панели Vivado Design Suite
нажать на кнопку Run Synthesis (рисунок 3.8).

Рисунок 3.8 – Кнопка запуска процесса синтеза

После нажатия на кнопку появится диалоговое окно с настройками синтеза (ри-
сунок 3.9). В окне настроек можно указать, в какое количество потоков (jobs) будет
производиться синтез. Для продолжения синтеза необходимо нажать OK.

После завершения синтеза откроется диалоговое окно с выбором следующего дей-
ствия (рисунок 3.10). При первом выполнении синтеза необходимо открыть синтези-
рованный проект, чтобы установить соответствие виртуальных портов ввода/вывода,
имеющихся в проекте, реальным портам ПЛИС. Для этого в открывшемся окне вы-
бираем Open Synthesized Design и нажимаем OK.

Чтобы перейти к редактированию назначения портов, надо в правом верхнем углу
открывшегося окна синтезированного проекта выбрать режим I/O Planning (рису-
нок 3.11).

В режиме I/O Planning необходимо задать соответствия портов в нижней части
окна проекта (область выделена красным на рисунке 3.12). Для всех дискретных
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Рисунок 3.9 – Диалоговое окно настройки синтеза

Рисунок 3.10 – Диалоговое окно открытия синтезированного проекта

портов ввода/вывода (переключатели, светодиоды и кнопки) необходимо в качестве
значения параметра IO Std задавать «LVCMOS33».

Информацию о названии реальных ножек ПЛИС и о том, к чему они подклю-
чены на плате, можно взять из официальной документации к плате. Подключение
дискретных портов ввода/вывода представлено на рисунке 3.13.

После завершения редактирования привязок необходимо сохранить изменения.
Это можно сделать комбинацией клавиш «Ctrl+S». При первом сохранении будет
показано окно с предложением ввести имя для вновь создаваемого файла ограни-
чений, в котором будут сохранены установленные настройки портов (рисунок 3.14).
Вводим имя и сохраняем ограничения в файл XDC.
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Рисунок 3.11 – Выбор режима I/O Planning

Рисунок 3.12 – Интерфейс редактирования привязки портов/ввода вывода

Заданные ограничения можно просмотреть в текстовом виде, щелкнув дважды
на названии файла в панели исходных файлов проекта (рисунок 3.15).

Нам необходимо также добавить ограничение на частоту тактового сигнала. На
рисунке 3.16 необходимая строчка выделена цветом. Выставляем ограничение на пе-
риод в 10 нс, что соответствует 100 МГц. Эта информация необходима Vivado для
правильного временного анализа схемы после размещения её компонентов на ПЛИС.
Если временные ограничения не будут соблюдаться, Vivado выдаст предупреждение.
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Рисунок 3.13 – Схема подключения дискретных портов ввода/вывода ПЛИС
XC7A100T-1CSG324C на плате Nexys 4 DDR

После задания ограничений необходимо перейти к этапу отображения схемы на
ресурсы ПЛИС и физическому размещению. Эти шаги запускаются нажатием на
Run Implementation в левой части интерфейса проекта Vivado (рисунок 3.17).

После успешного размещения схемы на ПЛИС будет предложено выполнить ге-
нерацию файла прошивки. Выбираем Generate Bistream и нажимаем OK (рису-
нок 3.18).
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Рисунок 3.14 – Диалоговое окно сохранения ограничений проекта

Рисунок 3.15 – Расположение файла ограничений проекта

После успешной генерации файла прошивки отобразится окно с предложением
открыть проект после размещения (рисунок 3.19). Можно нажать Cancel. Пока нам
не требуется вносить изменения в размещение на ПЛИС.
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Рисунок 3.16 – Содержимое файла ограничений проекта

Рисунок 3.17 – Кнопка запуска процесса отображения и размещения схемы на
ресурсах ПЛИС

Рисунок 3.18 – Окно с предложением генерации прошивки ПЛИС

Файл прошивки имеет расширение *.bit и располагается в каталоге с результата-
ми размещения проекта. Мы можем просмотреть количество ресурсов, занимаемых
проектом на ПЛИС в панели Design Runs (рисунок 3.20).
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Рисунок 3.19 – Окно с предложением открытия проекта после размещения

Рисунок 3.20 – Информация по занимаемым ресурсам ПЛИС

Также информацию о ресурсах можно просмотреть, нажав на символ суммы в
верхней инструментальной панели Vivado (рисунок 3.21). Откроется отчет об исполь-
зовании ресурсов (рисунок 3.22).

Рисунок 3.21 – Кнопка просмотра отчета по занимаемым ресурсам ПЛИС

Для проверки работоспособности схемы необходимо загрузить полученную про-
шивку на ПЛИС. Это можно сделать с помощью Hardware Manager, входящего в
состав Vivado. Также можно загрузить прошивку с помощью приложения IMPACT,
входящего в состав ISE Design Suite – предшественника Vivado. Далее будет описан
процесс загрузки прошивки с помощью Hardware Manager.
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Рисунок 3.22 – Отчет по занимаемым ресурсам ПЛИС

Для открытия Hardware Manager необходимо нажать на Open Hardware Manager
на левой панели Vivado (рисунок 3.23).

Рисунок 3.23 – Кнопка открытия режима прошивки ПЛИС

После открытия Hardware Manager необходимо подключить плату Nexys 4 DDR
к компьютеру и включить питание платы. Затем нажать на кнопку автоопределения
подключенного устройства – Auto Connect (рисунок 3.24).

Рисунок 3.24 – Кнопка автоопределения платы с ПЛИС
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После успешного определения ПЛИС необходимо щелкнуть правой кнопкой мыш-
ки на ней и выбрать Program Device (рисунок 3.25).

Рисунок 3.25 – Меню программирования ПЛИС

После нажатия на Program Device откроется диалоговое окно с выбором файла
прошивки. Если Hardware Manager запускается из текущего проекта, как в данном
примере, то путь к файлу прописывается автоматически. Для программирования
нажимаем Program (рисунок 3.26).

Рисунок 3.26 – Окно выбора файла прошивки

После успешного завершения процесса программирования можно увидеть на пла-
те результат работы спроектированной схемы.
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4 Лабораторная работа №4. Проектирование встро-

енных схем самотестирования

4.1 Введение

Лабораторная работа №4 посвящена вопросам разработки встроенных схем само-
тестирования для проектов на ПЛИС.

В процессе моделирования схемы в симуляторе невозможно точно учесть реаль-
ные временные задержки, а моделирование секунды жизни системы может занимать
минуты и часы реального времени. В связи с этим возникает проблема тестирования
системы с реальными задержками прохождения сигналов через элементы, а также
перебором всех необходимых тестовых векторов за минимальное время. Это воз-
можно осуществить с помощью встроенных блоков самотестирования, так как они
работают в реальном окружении и в реальном времени.

Блоки самотестирования позволяют проверить систему без подключения к внеш-
нему оборудованию, и их наличие актуально на всем протяжении эксплуатации систе-
мы. В процессе эксплуатации из-за воздействия различных факторов окружающей
среды (например, перегрева, повышенной влажности, присутствия электромагнит-
ного излучения и пр.) может происходить деградация элементной базы устройства,
что приводит к сбоям в работе системы. Регулярный запуск процесса самотести-
рования может помочь вовремя выявить нарушения работоспособности системы и
обезопасить окружение от последствий сбоев.

4.2 Описание лабораторной работы

Цель работы

Получить навыки разработки встроенных схем самотестирования (BIST, built-in
self-test) для цифровых устройств, реализованных на базе программируемых логи-
ческих интегральных схем (ПЛИС).

Указания к выполнению работы

Лабораторная работа посвящена знакомству с особенностями разработки встро-
енных схем самотестирования для цифровых устройств, реализованных на базе мик-
росхем ПЛИС. Работа выполняется в Vivado Design Suite и с использованием отла-
дочной платы Nexys 4 DDR (новое название Nexys A7).
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Порядок выполнения работы

1. Доработайте схему функционального блока, разработанного в лабораторной ра-
боте №3, в соответствии с рисунком 4.1. На рисунке данный блок обозначен как
DUT (Design under Test). Необходимо добавить в схему возможность выполнять
самотестирование по внешней команде – по факту нажатия кнопки. Схема са-
мотестирования должна удовлетворять следующим требованиям:

1.1. Вход и выход из режима самотестирования должен выполняться по факту
нажатия кнопки BTN.

1.2. Модуль «BIST control logic» должен управлять коммутацией сигналов в
режиме тестирования. Данный модуль также должен хранить количество
переходов в режим самотестирования с момента подачи питания на схему.

1.3. Должна быть поддержана возможность подавать вместо операндов функ-
ции значения с регистров сдвига с линейной обратной связью LFSR
(Linear-Feedback Shift Register). Регистры LFSR будут выполнять функции
генераторов псевдослучайных чисел. Полиномы, на базе которых работа-
ют регистры LFSR, определяются в варианте задания.

1.4. Значение выхода функционального блока (DUT) в режиме тестирования
должно проходить через модуль расчета циклического избыточного 8-
битного кода CRC8 (Cyclic Redundancy Check). По значению CRC8 в кон-
це тестирования определяется корректность работы схемы. Использование
такого подхода позволяет сэкономить память для записи истории тестиро-
вания и для списка эталонных значений на каждой итерации тестирования.
Полином для CRC8 определяется в варианте задания.

1.5. Результат работы блока в режиме самотестирования должен представлять
собой значение кода CRC8 после 256 итераций тестирования. Одной ите-
рацией тестирования называется расчет результата на одной комбинации
входных операндов.

1.6. В режиме тестирования на светодиоды должно выводиться значение CRC8
и количество переходов схемы в режим самотестирования с момента пода-
чи питания на схему. В режиме нормальной работы на светодиоды выво-
дится результат расчета функционального блока (DUT).

2. Разработайте тестовое окружение и проведите моделирование схемы. Опреде-
лите корректное значение CRC8 в конце процесса самотестирования, то есть
после 256 итераций смены входных операндов.
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3. Проведите синтез и размещение схемы для ПЛИС XC7A100T-1CSG324C, вхо-
дящей в состав отладочной платы Nexys 4 DDR.

4. Определите количество и тип используемых ресурсов ПЛИС после размещения
схемы.

5. Проверьте работоспособность схемы на отладочной плате Nexys 4 DDR в нор-
мальном режиме и в режиме самотестирования.

6. Составьте отчет по результатам выполнения работы.

Рисунок 4.1 – Схема сопряжения функционального блока со схемой тестирования:
BTN – тактовая кнопка, LEDS – светодиоды, DUT (Design under Test) – модуль из

лабораторной работы №3, LFSR 1 и LFSR 2 (Linear-Feedback Shift Register) –
регистры сдвига с линейной обратной связью, CRC8 (Cyclic Redundancy Check) –

модуль расчета циклического избыточного 8-битного кода

На рисунке 4.1 интерфейсы ввода/вывода блока DUT показаны упрощенно. Блок
DUT должен иметь интерфейсы, аналогичные тем, что были в лабораторной рабо-
те №3.

Требования к отчету

Отчет должен быть оформлен в соответствии с требованиями, представленными
в Приложении A.

Отчет должен включать:

1. Титульный лист.

2. Цель работы.

3. Задание в соответствии с вариантом.

4. Схемы (рисунки) устройства блока «BIST control logic», регистров LFSR и мо-
дуля расчета CRC8.
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5. Результат тестирования блока в симуляторе (временные диаграммы).

6. Время моделирования режима самотестирования в симуляторе.

7. График с плотностью распределения значений операндов, которые перебира-
ются в режиме самотестирования, с указанием области допустимых значений.

8. Процент количества значений операндов, которые попали в область допусти-
мых значений.

9. Таблицу с используемыми ресурсами ПЛИС.

10. Выводы по работе.

Задания по вариантам

№ вар. Полином LFSR 1 Полином LFSR 2 Полином CRC8
1 𝑦 = 1 + 𝑥+ 𝑥2 + 𝑥4 + 𝑥8 𝑦 = 1 + 𝑥2 + 𝑥3 + 𝑥5 + 𝑥8 𝑦 = 1 + 𝑥2 + 𝑥3 + 𝑥4 + 𝑥8

2 𝑦 = 1 + 𝑥2 + 𝑥4 + 𝑥5 + 𝑥8 𝑦 = 1 + 𝑥2 + 𝑥3 + 𝑥7 + 𝑥8 𝑦 = 1 + 𝑥4 + 𝑥5 + 𝑥7 + 𝑥8

3 𝑦 = 1 + 𝑥3 + 𝑥4 + 𝑥5 + 𝑥8 𝑦 = 1 + 𝑥+ 𝑥3 + 𝑥5 + 𝑥8 𝑦 = 1 + 𝑥4 + 𝑥6 + 𝑥7 + 𝑥8

4 𝑦 = 1 + 𝑥+ 𝑥5 + 𝑥6 + 𝑥8 𝑦 = 1 + 𝑥2 + 𝑥6 + 𝑥7 + 𝑥8 𝑦 = 1 + 𝑥3 + 𝑥5 + 𝑥7 + 𝑥8

5 𝑦 = 1 + 𝑥3 + 𝑥5 + 𝑥7 + 𝑥8 𝑦 = 1 + 𝑥4 + 𝑥6 + 𝑥7 + 𝑥8 𝑦 = 1 + 𝑥4 + 𝑥5 + 𝑥6 + 𝑥8

6 𝑦 = 1 + 𝑥+ 𝑥6 + 𝑥7 + 𝑥8 𝑦 = 1 + 𝑥2 + 𝑥4 + 𝑥5 + 𝑥8 𝑦 = 1 + 𝑥2 + 𝑥4 + 𝑥7 + 𝑥8

7 𝑦 = 1 + 𝑥4 + 𝑥6 + 𝑥7 + 𝑥8 𝑦 = 1 + 𝑥+ 𝑥6 + 𝑥7 + 𝑥8 𝑦 = 1 + 𝑥3 + 𝑥5 + 𝑥6 + 𝑥8

8 𝑦 = 1 + 𝑥3 + 𝑥4 + 𝑥6 + 𝑥8 𝑦 = 1 + 𝑥3 + 𝑥6 + 𝑥7 + 𝑥8 𝑦 = 1 + 𝑥+ 𝑥3 + 𝑥7 + 𝑥8

9 𝑦 = 1 + 𝑥5 + 𝑥6 + 𝑥7 + 𝑥8 𝑦 = 1 + 𝑥+ 𝑥3 + 𝑥5 + 𝑥8 𝑦 = 1 + 𝑥+ 𝑥3 + 𝑥4 + 𝑥8

10 𝑦 = 1 + 𝑥3 + 𝑥6 + 𝑥7 + 𝑥8 𝑦 = 1 + 𝑥2 + 𝑥4 + 𝑥5 + 𝑥8 𝑦 = 1 + 𝑥4 + 𝑥5 + 𝑥6 + 𝑥8
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4.3 Устройство и принцип работы регистров LFSR

LFSR (Linear-Feedback Shift Register) – регистр сдвига с линейной обратной свя-
зью. Основное назначение данного регистра – генерирование псевдослучайных зна-
чений. Структурную схему LFSR можно увидеть на рисунке 4.2. Как показано на
рисунке 4.2, для работы данного регистра необходимы сдвиговый регистр и функция
обратной связи. Входными параметрами для алгоритма генерации псевдослучайных
значений являются начальное состояние сдвигового регистра и значение порождаю-
щего полинома. Обобщенная форма полинома представлена в формуле (4.1).

𝑃 = 𝑐𝐿 * 𝑥𝐿 + ...+ 𝑐2 * 𝑥2 + 𝑐1 * 𝑥1 + 1 (4.1)

Рисунок 4.2 – Структурная схема LFSR-регистра

Как показано на рисунке 4.2, значение младшего бита сдвигового регистра опре-
деляется функцией обратной связи и зависит от значений всех битов регистра до их
сдвига. Перед расчетом значения функции обратной связи значения битов сдвигово-
го регистра умножаются на коэффициент c, который может принимать значения 0
или 1 (задается полиномом). При этом коэффициент для младшего разряда всегда
равен 1. Далее получившиеся коэффициенты попадают на функцию обратной свя-
зи. В качестве функции обратной связи наиболее часто используется сложение по
модулю 2 (XOR) или его логическая инверсия (XNOR). На рисунке 4.3 представле-
на структурная схема реализации блока обратной связи с использованием функции
XOR.

Таким образом, новое значение младшего разряда сдвигового регистра можно
рассчитать по формуле (4.2).

𝑥0 = (𝑥0 * 𝑐0)
⨁︁

(𝑥1 * 𝑐1)
⨁︁

(𝑥2 * 𝑐2).....
⨁︁

(𝑥𝐿−1 * 𝑐𝐿−1) (4.2)
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Рисунок 4.3 – Структурная схема LFSR-регистра и блока обратной связи на XOR

По формуле (4.2) можно увидеть, что количество аппаратных элементов XOR

будет определяться количеством коэффициентов, равных 1. Коэффициенты, в свою
очередь, задаются в бинарном полиноме.

В формуле (4.3) представлен пример 5-разрядного полинома.

𝑃 = 1 * 𝑥5 + 0 * 𝑥4 + 1 * 𝑥3 + 0 * 𝑥2 + 0 * 𝑥1 + 1 = 𝑥5 + 𝑥3 + 1 (4.3)

Таким образом для данного примера достаточно будет использовать всего 3 ап-
паратных XOR, поскольку коэффициент с, равный 1, установлен только для 5, 3 и
0 битов сдвигового регистра.

На сегодняшний день существуют два варианта реализации регистра LFSR: внеш-
ний (external, рисунок 4.4) и внутренний (internal, рисунок 4.5).

Рисунок 4.4 – Внешний (external) LFSR-регистр

75



Рисунок 4.5 – Внутренний (internal) LFSR-регистр

Для внешнего LFSR-регистра результат функции обратной связи записывается в
младший разряд сдвигового регистра, а в остальные разряды записывается значение
предыдущего бита. Таким образом, внешний LFSR реализует следующую последо-
вательность действий:

1. Установить начальное значение сдвигового регистра.

2. Произвести умножение каждого разряда сдвигового регистра на заданный ко-
эффициент c.

3. Рассчитать значение нового бита на основе функции обратной связи.

4. Произвести сдвиг регистра.

5. В освободившийся разряд записать новое значение, полученное на шаге 3 (в ре-
зультате будет получено новое псевдослучайное число).

6. Повторять шаги 2-5 для получения новых псевдослучайных чисел.

В случае внутреннего LFSR-регистра новое значение каждого разряда является
результатом операции сложения по модулю 2 с результатом умножения старшего
разряда на коэффициенты порождающего полинома.
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4.4 Алгоритм расчета кода CRC8

CRC (Cyclic Redundancy Check) – циклический избыточный код, который предна-
значен для проверки целостности данных. CRC8 является одной из разновидностей
кода CRC. Алгоритм расчета CRC8 подразумевает, что выходная контрольная сум-
ма записывается в 8-разрядный регистр. Значение CRC может быть рассчитано по
формуле (4.4).

𝑅(𝑥) = 𝑃 (𝑥) * 𝑥𝑁𝑚𝑜𝑑𝐺(𝑥), (4.4)

где R(x) – многочлен, представляющий значение CRC; P(x) – многочлен, коэф-
фициенты которого представляют входные данные; G(x) – порождающий полином;
N – степень многочлена.

Значение CRC является остатком от деления многочлена, соответствующего вход-
ным данным, на фиксированный порождающий полином. Порождающий полином
представлен в формуле (4.5).

𝐺(𝑥) = 𝑐𝐿 * 𝑥𝐿 + ...+ 𝑐2 * 𝑥2 + 𝑐1 * 𝑥1 + 𝑐1 * 𝑥0, (4.5)

где c является коэффициентом, который может принимать значения 0 или 1.
Для расчета CRC8 используют восьмиразрядный сдвиговый регистр. На рисун-

ке 4.6 представлена схема вычисления CRC8 с полиномом 𝑥8 + 𝑥5 + 𝑥4 + 1.

Рисунок 4.6 – Схема расчета CRC8 с порождающим полиномом 𝑥8 + 𝑥5 + 𝑥4 + 1

В процессе расчета CRC8 в восьмиразрядный регистр побитово поступают вход-
ные данные со стороны младшего разряда. Если выдвигаемый (старший) бит равен 1,
то происходит сложение по модулю 2 коэффициентов порождающего полинома и со-
держимого регистра.

Для обработки данных по словам в 8 бит, то есть побайтово, можно воспользо-
ваться следующим алгоритмом:

1. Установить начальное значение CRC.

2. Загрузить указанное слово в регистр данных.
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3. Произвести операцию сложения по модулю 2 со значением регистра данных и
текущим значением CRC.

4. Загрузить результат в сдвиговый регистр.

5. Произвести сдвиг данных в сторону старших разрядов.

6. Если выдвинутый бит равен 0, перейти к шагу 8.

7. Произвести операцию сложения по модулю 2 значения сдвигового регистра с
коэффициентами полинома.

8. Загрузить результат в регистр CRC.

9. Повторить шаги с 3 по 8 (количество повторений равно длине слова, то есть 8
раз).

10. Повторить шаги с 2 по 9 (количество повторений равно количеству слов).

Поскольку значение полинома и начальное значение регистра CRC нам извест-
ны, и эти данные не меняются со временем, то можно заранее рассчитать значение
CRC для входных данных и сохранить эти значения в память. Таким образом, ал-
горитм расчета нового значения CRC сводится к чтению данных из памяти, где
входное значение будет выступать в роли адреса для доступа к памяти. При этом
скорость работы данного алгоритма ограничена скоростью операции чтения данных
из памяти. Табличный метод будет работать значительно быстрее, но при этом будет
требовать больше ресурсов памяти на кристалле.

Для реализации табличного метода необходимо выполнить следующую последо-
вательность действий:

1. Установить начальное значение CRC.

2. Загрузить слово данных в регистр данных.

3. Произвести операцию сложения по модулю 2 значения регистра данных и те-
кущего значения CRC.

4. Полученный на шаге 3 результат подать в качестве адреса ячейки памяти.

5. Сохранить считанное из памяти значение в регистр CRC.

6. Повторить шаги с 2 по 5 (количество повторений равно количеству слов).
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4.5 Дребезг контактов и вариант блока защиты для

его устранения

Дребезг контактов – явление, возникающее в электрических и электронных пе-
реключателях, при котором они вместо некоторого стабильного сигнала выдают на
выходе случайные высокочастотные колебания.

Причина возникновения дребезга заключается в механической конструкции кно-
пок и переключателей, которая не позволяет мгновенно зафиксировать контакт. На
рисунке 4.7 показан пример временных диаграмм идеального и реального нажатий
на кнопку. Как видно из диаграмм, на реальном объекте может возникать хаотич-
ное изменение состояния входного сигнала. При неправильной обработке нажатия
кнопки программная логика может воспринимать данное поведение как многократ-
ное нажатие кнопки. Таким образом, для нормальной работы схемы сигнал предва-
рительно необходимо обработать. При проектировании схем обработки необходимо
понимать, что дребезг может возникать как в моменты переключения кнопки или
переключателя, так и во время удержания.

Рисунок 4.7 – Временные диаграммы нажатия на кнопку

В электронике одной из самых простых и распространенных схем для устранения
подобного рода помех является RC-фильтр нижних частот (LPF, Low Pass Filter),
который представлен на рисунке 4.8. Данная схема за счет значительного времени
зарядки и разрядки конденсатора преобразует динамически изменяющийся высоко-
частотный сигнал в постоянное значение.

На верхней части рисунка 4.9 показан входной сигнал (LPF input), поступающий
на RC-фильтр, на нижней части – выходной (LPF output). Как видно из рисунка 4.9,
на входном сигнале имеются высокочастотные помехи, но их период значительно
меньше постоянной времени RC-цепи. Поэтому на выходном сигнале данные помехи
не наблюдаются. Таким образом, для корректной работы этой схемы необходимо
правильно подобрать постоянную времени RC-цепи.
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Рисунок 4.8 – RC-фильтр нижних частот

Рисунок 4.9 – Временные диаграммы RC-фильтра нижних частот

Аналогичный фильтр можно использовать и для обработки события нажатия
кнопки в проектах на основе ПЛИС. Таким образом, задача обработки кнопки сво-
дится к реализации фильтра нижних частот с использованием элементов цифровой
схемотехники. Структурная схема данной реализации представлена на рисунке 4.10.

Как видно из рисунка, входной сигнал поступает на триггер, после чего перехо-
дит на компаратор. На компараторе происходит его сравнение с текущим выходным
сигналом. Если входное значение отличается от выходного, то считается, что про-
изошло событие (кнопку нажали или отпустили). С этого момента устанавливается
сигнал разрешения счетчика, при этом счетчик будет изменять свое значение при
каждом фронте тактового сигнала. В противном случае счетчик находится в сбро-
шенном состоянии. Значение счетчика поступает на вход еще одного компаратора,
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Рисунок 4.10 – Реализация фильтра нижних частот на цифровых элементах

который проверяет его значение на равенство константе К. Значение К, аналогич-
но постоянной времени RC-цепи, подбирается для каждой задачи в соответствии с
особенностями данной задачи. При равенстве счетчика значению К устанавливает-
ся сигнал разрешения обновления данных на выходном триггере. Новым значением
выходного сигнала является его инверсное значение.

Разработанная схема имеет один большой недостаток – она не учитывает, что со-
бытие нажатия кнопки по определению является асинхронным по отношению к внут-
ренней логике, реализованной на ПЛИС. Смена логического состояния на входной
ножке ПЛИС может совпасть с моментом переключения принимающего триггера,
и есть вероятность, что триггер окажется в метастабильном состоянии. Это может
привести к непредсказуемым результатам. Следовательно, необходимо избавиться
от потенциально возможного метастабильного состояния. Добиться этого можно за
счет использования схем синхронизации. Простейшей схемой синхронизации могут
служить два последовательно подключенных триггера, тактируемые от одного так-
тового сигнала. Доработанную схему фильтра можно увидеть на рисунке 4.11. Как
видно на рисунке, входной сигнал сначала поступает на вход цепи синхронизации,
состоящей из двух триггеров, и только после этого поступает на вход фильтра.

Рисунок 4.11 – Программная реализация фильтра нижних частот со схемой
синхронизации

Также в ряде задач необходимо выделять момент нажатия или отпускания кноп-
ки. Необходимого поведения можно добиться путем подачи сигнала out на схему
выделения момента изменения сигнала. На рисунке 4.12 представлена схема выде-
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ления переднего фронта сигнала, а на рисунке 4.13 представлена схема выделения
заднего фронта (спада). На рисунке 4.14 представлена схема выделения момента
любого изменения сигнала.

Рисунок 4.12 – Схема выделения переднего фронта сигнала

Рисунок 4.13 – Схема выделения заднего фронта (спада) сигнала

Рисунок 4.14 – Схема выделения момента изменения сигнала
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5 Лабораторная работа №5. Проектирование кон-

троллеров ввода и индикации

5.1 Введение

Лабораторная работа №5 посвящена развитию навыков работы с дискретными
портами ввода, подключенными к переключателям и кнопкам, а также освоению
принципов взаимодействия с простейшими устройствами индикации – светодиодами
и семисегментными индикаторами.

В работе предлагается разработать устройство аппаратного контроллера ввода и
индикации с использованием языка описания аппаратуры Verilog HDL. После этого
необходимо выполнить прототипирование устройства на отладочной плате Nexys 4
DDR с ПЛИС XC7A100T-1CSG324C.

Для успешного запуска проекта на ПЛИС необходимо использовать синтезируе-
мое подмножество языка Verilog HDL.

5.2 Описание лабораторной работы

Цель работы

Освоение работы с базовыми дискретными элементами ввода/вывода: светодио-
ды, кнопки, позиционные переключатели, семисегментные индикаторы.

Указания к выполнению работы

Работа выполняется в Vivado Design Suite и с использованием отладочной платы
Nexys 4 DDR (новое название Nexys A7).

Порядок выполнения работы

1. Разработайте архитектуру устройства, указанного в варианте задания.

2. Опишите RTL-модель устройства с использованием языка Verilog HDL.

3. Разработайте тестовое окружение и план тестирования разработанной RTL-
модели.

4. Проведите отладку и тестирование RTL-модели в симуляторе.
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5. Выполните синтез RTL-модели устройства на аппаратные ресурсы ПЛИС
Artix-7 XC7A100T-1CSG324C.

6. Проведите прототипирование разработанного устройства на отладочной плате
Nexys 4 DDR.

7. Составьте отчет по результатам выполнения работы.

Требования к отчету

Отчет должен быть оформлен в соответствии с требованиями, представленными
в Приложении A.

Отчет должен включать:

1. Титульный лист.

2. Цель работы.

3. Задание в соответствии с вариантом.

4. Структурную схему RTL-модели разрабатываемого устройства. Структурную
схему сопроводить комментариями, поясняющими алгоритм работы устрой-
ства.

5. Описание структуры тестового окружения и плана тестирования.

6. Временные диаграммы, доказывающие корректность работы разработанного
устройства. Временные диаграммы сопроводить комментариями.

7. Выводы по работе.
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Задания по вариантам

Вариант 1

Реализовать модуль управления трехцветным светодиодом LD17 отладочной пла-
ты Nexys 4 DDR.

Светодиод должен в непрерывном режиме отображать следующую цветовую ани-
мацию:

1. В течение 1 с плавно загорается красный светодиод и остается в активном
состоянии.

2. В течение 1 с плавно загорается синий светодиод и остается в активном состо-
янии.

3. В течение 1 с плавно загорается зеленый светодиод и остается в активном со-
стоянии.

4. В течение 1 с плавно гаснет зеленый светодиод.

5. В течение 1 с плавно гаснет синий светодиод.

6. В течение 1 с плавно гаснет красный светодиод.

Шаги 1-6 непрерывно циклически повторяются.
Плавное включение-выключение необходимо реализовать с использованием

широтно-импульсной модуляции (ШИМ) сигнала, подаваемого на светодиод опре-
деленного цвета. Яркость светодиода варьируется изменением скважности сигнала.
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Вариант 2

Реализовать модуль светодиодной индикации, выводящий анимацию по заданно-
му алгоритму на линейку из 16 светодиодов отладочной платы Nexys 4 DDR. Кадры
анимации представлены в таблице 5.1.

Таблица 5.1 – Описание кадров анимации варианта 2

Кадр Состояние линейки светодиодов LED[15:0]
1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
2 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1
3 1 1 0 0 0 0 0 0 0 0 0 0 0 0 1 1
4 1 1 1 0 0 0 0 0 0 0 0 0 0 1 1 1
5 1 1 1 1 0 0 0 0 0 0 0 0 1 1 1 1
6 1 1 1 1 1 0 0 0 0 0 0 1 1 1 1 1
7 1 1 1 1 1 1 0 0 0 0 1 1 1 1 1 1
8 1 1 1 1 1 1 1 0 0 1 1 1 1 1 1 1
9 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1
10 0 1 1 1 1 1 1 1 1 1 1 1 1 1 1 0
11 0 0 1 1 1 1 1 1 1 1 1 1 1 1 0 0
12 0 0 0 1 1 1 1 1 1 1 1 1 1 0 0 0
13 0 0 0 0 1 1 1 1 1 1 1 1 0 0 0 0
14 0 0 0 0 0 1 1 1 1 1 1 0 0 0 0 0
15 0 0 0 0 0 0 1 1 1 1 0 0 0 0 0 0
16 0 0 0 0 0 0 0 1 1 0 0 0 0 0 0 0

Кадры 1-16 непрерывно циклически повторяются. Должно быть реализовано че-
тыре режима скорости смены кадров:

1. SW[1:0] = 0 – анимация остановлена, отображается последний кадр.

2. SW[1:0] = 1 – смена каждые 1000 мс.

3. SW[1:0] = 2 – смена каждые 500 мс.

4. SW[1:0] = 3 – смена каждые 200 мс.

Режим скорости анимации задается с помощью двух переключателей SW[1:0].
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Вариант 3

Реализовать модуль светодиодной индикации, выводящий анимацию по заданно-
му алгоритму на линейку из 16 светодиодов отладочной платы Nexys-4 DDR. Кадры
анимации представлены в таблице 5.2.

Таблица 5.2 – Описание кадров анимации варианта 3

Кадр Состояние линейки светодиодов LED[15:0]
1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
2 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1
3 1 1 0 0 0 0 0 0 0 0 0 0 0 0 1 1
4 1 1 1 0 0 0 0 0 0 0 0 0 0 1 1 1
5 1 1 1 1 0 0 0 0 0 0 0 0 1 1 1 1
6 1 1 1 1 1 0 0 0 0 0 0 1 1 1 1 1
7 1 1 1 1 1 1 0 0 0 0 1 1 1 1 1 1
8 1 1 1 1 1 1 1 0 0 1 1 1 1 1 1 1
9 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1
10 1 1 1 1 1 1 1 0 0 1 1 1 1 1 1 1
11 1 1 1 1 1 1 0 0 0 0 1 1 1 1 1 1
12 1 1 1 1 1 0 0 0 0 0 0 1 1 1 1 1
13 1 1 1 1 0 0 0 0 0 0 0 0 1 1 1 1
14 1 1 1 0 0 0 0 0 0 0 0 0 0 1 1 1
15 1 1 0 0 0 0 0 0 0 0 0 0 0 0 1 1
16 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1

Кадры 1-16 непрерывно циклически повторяются. Должно быть реализовано че-
тыре режима скорости смены кадров:

1. SW[1:0] = 0 – анимация остановлена, отображается последний кадр.

2. SW[1:0] = 1 – смена каждые 1000 мс.

3. SW[1:0] = 2 – смена каждые 500 мс.

4. SW[1:0] = 3 – смена каждые 200 мс.

Режим скорости анимации задается с помощью двух переключателей SW[1:0].
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Вариант 4

Разработать модуль таймера с отображением значений на линейке семисегмент-
ных индикаторов.

При реализации таймера используются четыре семисегментных индикатора для
отображения минут, два индикатора для отображения секунд, два индикатора для
отображения миллисекунд.

Предусмотреть возможность сброса значения таймера по факту нажатия на кноп-
ку BTNC.

Вариант 5

Разработать контроллер бегущей строки с отображением анимации на линейке
семисегментных индикаторов.

На семисегментные индикаторы должна выводиться строка HELLO по алгоритму,
представленному в таблице 5.3.

Таблица 5.3 – Описание кадров анимации варианта 5

Кадр Состояния индикаторов
1 - - - - - - - -
2 O - - - - - - -
3 L O - - - - - -
4 L L O - - - - -
5 E L L O - - - -
6 H E L L O - - -
7 - H E L L O - -
8 - - H E L L O -
9 - - - H E L L O
10 - - - - H E L L
11 - - - - - H E L
12 - - - - - - H E
13 - - - - - - - H

Кадры 1-13 непрерывно циклически повторяются. Предусмотреть возможность
сброса анимации в начало по факту нажатия на кнопку BTNC.
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6 Лабораторная работа №6. Основы проектирования

контроллеров периферийных устройств

6.1 Введение

Лабораторная работа №6 направлена на развитие навыков проектирования кон-
троллеров последовательных интерфейсов ввода/вывода, а также аппаратных бло-
ков обработки данных с внешних датчиков и устройств ввода/вывода. Для развития
базовых навыков студентам предлагается разработать контроллеры для таких ин-
терфейсов, как SPI, UART, I2C, PS/2, а также аппаратные блоки обработки данных
с датчиков температуры, освещенности, прикосновений, джойстика, мыши и клави-
атуры.

Разработанные проекты необходимо протестировать и отладить с использовани-
ем отладочной платы Nexys 4 DDR с ПЛИС XC7A100T-1CSG324C и необходимых
устройств ввода/вывода.

6.2 Описание лабораторной работы

Цели работы

1. Знакомство с принципами работы последовательных интерфейсов ввода/выво-
да SPI, UART, I2C, PS/2.

2. Изучение основ разработки аппаратных контроллеров периферийных
устройств.

3. Изучение основ работы с цифровыми датчиками.

Указания к выполнению работы

Работа выполняется в Vivado Design Suite и с использованием отладочной платы
Nexys 4 DDR (новое название Nexys A7) с необходимыми устройствами ввода/вывода.

Порядок выполнения работы

1. Разработайте архитектуру устройства, указанного в варианте задания. Необхо-
димо разделить контроллер интерфейса и блок прикладной логики.
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2. Опишите RTL-модель устройства с использованием языка Verilog HDL. Кон-
троллер интерфейса должен находиться в отдельном модуле.

3. Разработайте тестовое окружение и план тестирования разработанной RTL-
модели.

4. Проведите отладку и тестирование RTL-модели в симуляторе.

5. Выполните синтез RTL-модели устройства на аппаратные ресурсы ПЛИС
Artix-7 XC7A100T-1CSG324C.

6. Проведите прототипирование разработанного устройства на отладочной плате
Nexys 4 DDR.

7. Составьте отчет по результатам выполнения работы.

Требования к отчету

Отчет должен быть оформлен в соответствии с требованиями, представленными
в Приложении A.

Отчет должен включать:

1. Титульный лист.

2. Цели работы.

3. Задание в соответствии с вариантом.

4. Структурную схему RTL-модели разрабатываемого устройства. Структурную
схему сопроводить комментариями, поясняющими алгоритм работы устрой-
ства.

5. Описание структуры тестового окружения и плана тестирования.

6. Временные диаграммы, доказывающие корректность работы разработанного
устройства. Временные диаграммы сопроводить комментариями.

7. Выводы по работе.
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Задания по вариантам

Вариант 1

Разработать контроллер, взаимодействующий с датчиком температуры ADT7420.
Контроллер должен реализовывать следующие функции:

1. Поддерживать обмен данными с датчиком температуры посредством интер-
фейса I2C.

2. Выводить на линейку светодиодов одно из двух значений в зависимости от
текущего состояния переключателя SW[0]:
− 0 – ID устройства датчика;
− 1 – текущая температура в градусах Цельсия.

Вариант 2

Разработать контроллер, взаимодействующий с датчиком освещенности
PmodALS. Контроллер должен реализовывать следующие функции:

1. Поддерживать обмен данными с датчиком освещенности посредством интер-
фейса SPI.

2. При значении переключателя SW[0] = 0 показывать факт наличия света в
аудитории с помощью светодиодов: LED[15:0] = 0xFFFF – свет выключен,
LED[15:0] = 0x0000 – свет включен. Таким образом, все светодиоды должны
загораться, когда свет в аудитории выключается, и гаснуть – когда свет в ауди-
тории включен.

3. При значении переключателя SW[0] = 1 показывать на светодиодах текущее
значение освещенности, считанное с датчика.

Вариант 3

Разработать контроллер, взаимодействующий с датчиком прикосновения
PmodCDC1. Контроллер должен реализовывать следующие функции:

1. Поддерживать обмен данными с датчиком прикосновения посредством интер-
фейса I2C.

2. Выводить на линейку светодиодов одно из четырех значений в зависимости от
текущего состояния переключателей SW[1:0]:
− 0x0 – константа 0x00;
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− 0x1 – текущее значение интенсивности прикосновения к кнопке BTN1;
− 0x2 – текущее значение интенсивности прикосновения к кнопке BTN2;
− 0x3 – выводить на светодиод LED[0] факт прикосновения к кнопке BTN1, а

на светодиод LED[1] – факт прикосновения к кнопке BTN2 (прикосновение
есть – соответствующий светодиод горит, прикосновения нет – светодиод
не горит).

Вариант 4

Разработать контроллер, взаимодействующий с джойстиком PmodJSTK. Кон-
троллер должен реализовывать следующие функции:

1. Поддерживать обмен данными с платой джойстика посредством интерфейса
SPI.

2. Выводить на линейку светодиодов одно из четырех значений в зависимости от
текущего состояния переключателей SW[1:0]:
− 0x0 – константа 0x00;
− 0x1 – текущее смещение джойстика по координате X;
− 0x2 – текущее смещение джойстика по координате Y;
− 0x3 – выводить на светодиоды LED[2:0] значения кнопок платы джойстика,

на LED[3] – факт перемещения джойстика вверх, на LED[4] – вниз, на
LED[5] – влево, на LED[6] – вправо (перемещение есть – соответствующий
светодиод горит, перемещения нет – светодиод не горит).

Вариант 5

Разработать контроллер, взаимодействующий с компьютером по последователь-
ному интерфейсу UART. Контроллер должен реализовывать следующие функции:

1. Поддерживать обмен данными с компьютером по интерфейсу UART (скорость
9600 бит/с, без контроля четности, один стоп-бит, длина слова восемь бит).

2. Постоянно выводить последнее принятое слово на светодиоды LED[7:0].

3. Работать в двух режимах в зависимости от состояния переключателя SW[0]:
− 0 – режим «эхо» (принятое по UART слово отправляется обратно);
− 1 – с периодичностью в 1000 мс отправляется строка «Hello world».
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Вариант 6

Разработать контроллер, взаимодействующий с клавиатурой по интерфейсу PS/2.
Контроллер должен реализовывать следующие функции:

1. Поддерживать обмен данными с клавиатурой по интерфейсу PS/2.

2. Выводить на светодиоды скан-код последней нажатой клавиши.

3. Изменять состояние светодиодов клавиатуры при нажатии кнопок на отладоч-
ной плате (BTNL – Num Lock, BTNC – Caps Lock, BTNR – Scroll Lock).

4. Изменять состояние светодиодов клавиатуры при нажатии соответствующих
кнопок на клавиатуре.

Вариант 7

Разработать контроллер, взаимодействующий с мышью по интерфейсу PS/2. Кон-
троллер должен реализовывать следующие функции:

1. Поддерживать обмен данными с мышью по интерфейсу PS/2.

2. Конфигурировать мышь в потоковый режим передачи данных (stream).

3. При значении переключателя SW[0] = 0 выводить на светодиоды LED[7:0] слово
статуса мыши (1 байт информационной посылки от мыши).

4. При значении переключателя SW[0] = 1 выводить на светодиоды последнее сме-
щение мыши по осям X и Y. Смещение по оси X отображается на светодиодах
LED[7:0], смещение по оси Y – на LED[15:8].
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A Требования к оформлению отчетов по лаборатор-

ным работам

1. Отчет выполняется в виде самодостаточного документа. Материал, изложен-
ный в отчете, должен быть понятен без дополнительных комментариев со сто-
роны исполнителей.

2. Отчет выполняется как текстовый документ в соответствии с ГОСТ 2.105-95.

3. Размер шрифта основного текста 12-14 pt (Times, Calibri или аналогичный),
межстрочный интервал 1-1,5, поля с краев листа не менее 2 см.

4. Листы отчета должны быть пронумерованы, кроме титульного листа, который
считается первым.

5. Если отчет содержит большое количество листов, рекомендуется добавлять
лист с содержанием отчета (разделы и номера листов).

6. На титульном листе указывается следующая информация:
− название университета;
− название факультета;
− название дисциплины;
− номер и тема лабораторной работы;
− вариант лабораторной работы;
− фамилия, инициалы и номер группы каждого исполнителя;
− фамилия и инициалы преподавателя;
− текущий год.

7. Обязательны нумерация и подписи к рисункам и таблицам, а также ссылки на
них в тексте отчета.

8. Схемы и временные диаграммы должны быть темными на светлом фоне.

9. В распечатанном отчете линии на схемах и временных диаграммах должны
быть четко видны.

10. На временных диаграммах не допускается наложение графиков сигналов друг
на друга, если это мешает их однозначному восприятию. В таких случаях сиг-
налы должны быть разнесены на отдельные координатные сетки.
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